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MXWneXt   
MXW neXt

Update Firmware
For the best experience, keep the firmware on your device up to date.

Important Safety Information
Explanation of Symbols

This symbol indicates that dangerous voltage constituting a risk of electric shock is present within this unit.

This symbol indicates that there are important operating and maintenance instructions in the literature accom-
panying this unit.

Important Safety Instructions
READ these instructions.
KEEP these instructions.
HEED all warnings.
FOLLOW all instructions.
DO NOT use this apparatus near water.
CLEAN ONLY with dry cloth.
DO NOT block any ventilation openings. Allow sufficient distances for adequate ventilation and install in accordance 
with the manufacturer’s instructions.
DO NOT install near any heat sources such as open flames, radiators, heat registers, stoves, or other apparatus (in-
cluding amplifiers) that produce heat. Do not place any open flame sources on the product.
DO NOT defeat the safety purpose of the polarized or grounding type plug. A polarized plug has two blades with one 
wider than the other. A grounding type plug has two blades and a third grounding prong. The wider blade or the third 
prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replace-
ment of the obsolete outlet.
PROTECT the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.
ONLY USE attachments/accessories specified by the manufacturer.
USE only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a 
cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

UNPLUG this apparatus during lightning storms or when unused for long periods of time.
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REFER all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any 
way, such as power supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, 
the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
DO NOT expose the apparatus to dripping and splashing. DO NOT put objects filled with liquids, such as vases, on the 
apparatus.
The MAINS plug or an appliance coupler shall remain readily operable.
The airborne noise of the Apparatus does not exceed 70dB (A).
Apparatus with CLASS I construction shall be connected to a MAINS socket outlet with a protective earthing connec-
tion.
To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.
Do not attempt to modify this product. Doing so could result in personal injury and/or product failure.
Operate this product within its specified operating temperature range.
Follow local regulations and consult qualified personnel if the product installation or relocation requires construction 
work. Choose mounting hardware and an installation location that can support the weight of the product. Avoid loca-
tions subject to constant vibration. Use the required tools to install the product properly. Inspect the product periodically.
If your product has a feature to log in, upon first time start up, you must change your password.

WARNING:

Voltages in this equipment are hazardous to life. No user-serviceable parts inside. Refer all servicing to qualified service 
personnel. The safety certifications do not apply when the operating voltage is changed from the factory setting.
If water or other foreign objects enter the inside of the device, fire or electric shock may result.

Note: Use only with the included power supply, batteries, or a Shure-approved equivalent.

Safety and Regulatory Information for Battery Chargers
This equipment is intended to be used in professional audio applications.
Use this battery charger only with the Shure charging modules and battery packs for which it is designed. Use with oth-
er than the specified modules and battery packs may increase the risk of fire or explosion.
Changes or modifications not expressly approved by Shure Incorporated could void your authority to operate this 
equipment.

Important Safety Instructions for Listening and IEM Products
If water or other foreign objects enter the inside of the device, fire or electric shock may result.
Do not attempt to modify this product. Doing so could result in personal injury and/or product failure.
Do not use when a failure to hear your surroundings could be dangerous, such as while driving, or when biking, walk-
ing, or jogging where traffic is present and accidents could occur.
Keep this product and its accessories out of reach of children. Handling or use by children may pose a risk of death or 
serious injury. Contains small parts and cords that may pose risk of choking or strangulation.
Prior to inserting the earphone, always recheck the sleeve to make sure it is firmly attached to the nozzle to decrease 
the risk of sleeves detaching from the nozzle and becoming lodged in your ear. If a sleeve becomes lodged in your ear, 
seek professional medical assistance to remove the sleeve.
Stop using the earphones/headphones and consult a medical professional if you experience irritation, excessive wax 
buildup, or other discomfort.

CAUTION

Never disassemble or modify the device, as failures may result.
Do not subject to extreme force and do not pull on the cable or failures may result.
Keep the earphone dry and avoid exposure to extreme temperatures and humidity.
If you are currently receiving ear treatment, consult your physician before using this device.

WARNING:
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Use, clean, and maintain earphones according to manufacturer’s instructions

High sound pressure

Hearing damage risk

To prevent possible hearing damage, do not listen at high volume levels for long periods.

WARNING FOR IN-EAR-MONITORS (IEM product_ONLY)
This device is able to produce sound volume higher than 85 dB SPL. Please check your maximum allowed continuous noise exposure level based on your na-
tional employment protection requirements.

WARNING:
LISTENING TO AUDIO AT EXCESSIVE VOLUMES CAN CAUSE PERMANENT HEARING DAMAGE. USE AS LOW A VOL­
UME AS POSSIBLE. Over exposure to excessive sound levels can damage your ears resulting in permanent noise-induced 
hearing loss (NIHL). Please use the following guidelines established by the Occupational Safety Health Administration (OSHA) 
on maximum time exposure to sound pressure levels before hearing damage occurs.

90 dB SPL

at 8 hours

95 dB SPL

at 4 hours

100 dB SPL

at 2 hours

105 dB SPL

at 1 hour

110 dB SPL

at ½ hour

115 dB SPL

at 15 minutes

120 dB SPL

Avoid or damage may occur

What is MXW neXt?
MXW neXt is a complete 2-, 4-, or 8-channel solution for meeting room and presentation applications. Developed with Dante
technology by Audinate, digital audio is routed over standard IP equipment across a network of access points, digital-to-analog 
converters, and computers. Access points add wireless, analog, and USB audio to the network. Docking stations enable micro-
phone linking, recharge microphones without battery removal, and network battery status for remote monitoring. RF coordina-
tion is automatic and continuous, offering worry-free wireless audio transmission for every event.

®
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① MXW-X Microphones
Wireless microphones are available in gooseneck, boundary, handheld and bodypack models.

② Access Point Transceiver (APX4 / APX8)
Sleek and unobtrusive, the MXWAPX mounts to a wall or ceiling to provide direct, line-of-sight wireless connection to the 
microphones. Powered by PoE, the APX features IntelliMix  DSP functionality, and automatically manages the RF spec-
trum, ensuring consistent, stable audio transport from the microphones.

③ Networked Docking Station (NDX4 / NDX4G / NDX8 / NDX8G)
The MXWNDX networked docking station enables microphone linking to connected APX access points, recharges micro-
phones without battery removal, updates firmware of docked microphones, and networks battery status for remote monitor-
ing. Docking stations are networkable via Ethernet and powered by USB-C PD.

NDX4 and NDX8 are compatible with bodypack, handheld, and boundary microphones, NDX4G and NDX8G are compatible 
with boundary and gooseneck microphones.

④ "All-In-One" Two Channel Transceiver/Docking Station/DSP (APXD2)
Featuring Dante, USB, and analog audio connections, acoustic echo cancellation (AEC) and Automix technology, wireless 
microphone linking, and transmitter charging ports, the APXD2 allows for networked or standalone operation.

⑤ Control Software
MXW neXt devices include a built-in web application for device control when networked to a computer.

⑥ Connections
Connect directly to audio and videoconferencing devices, as well as monitoring and control software. Use shielded Cat5e 
cables (or better) and a PoE-capable network switch for best results.

™
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Getting Started with MXW neXt 2
MXW neXt 2 is an all-in-one wireless microphone system featuring the APXD2, which combines a 2-channel wireless trans-
ceiver, digital audio processing and two charging bays into a convenient tabletop device. On-board Dante, analog and USB au-
dio connections enable local sound reinforcement and video conferencing applications in either standalone or networked instal-
lations. RF coordination is automatic and continuous, offering worry-free wireless audio transmission for every event.

Setting Up Your Hardware
Connect the APXD2's power supply to the POWER input on the back of the device and a power source. The LEDs on 
the front panel will illuminate as the APXD2 turns on.

When the APXD2 has finished booting up, a single LED will illuminate on the front panel.

Place the microphones in the docking bays of the APXD2. When docked successfully, the microphones will turn on, and 
the battery LEDs on the APXD2 will illuminate. The microphone displays will also show the charging status.
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4. To link the microphones to the APXD2, press and hold the link button for approximately 3 seconds. The link LED on the 
APXD2 will turn solid green when the microphones are linked. The microphones are now linked to the APXD2 channel 
corresponding to the docking bay each microphone is placed in.

Verify that audio is passing through the system by undocking each microphone and talking into it. The audio meter LEDs on the 
front panel should light up in response to your voice on each channel.
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Your MXW neXt 2 system is ready to use.

Updating Firmware
After connecting your hardware to the same Ethernet network on the same local subnet, install the latest firmware update using 
the Shure Update Utility (www.shure.com/suu). Connect your computer to the same network and subnet, and dock any micro-
phones in your docking station.

CAUTION! Ensure the device has a stable network connection during the update. Do not turn off any device until the update is 
complete.

Operation Modes
The APXD2 has four operation modes, which change the audio routing and mic muting behavior. To cycle between the different 
modes, press the Mode button on the front panel of the APXD2.

Mode Details

Presentation

Share your presentation with local sound reinforcement, with a variety of 
mixed outputs.

Automix and AEC are enabled
Mute behavior is Local-Individual (microphones mute/unmute indepen-
dently from each other)
3 mixed Dante outputs

Conference
Connect to your preferred videoconferencing software.

Automix and AEC are enabled
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Mode Details

Mute behavior is USB Mute Sync (mute state, controlled by microphones 
or external conferencing software, is applied universally to all linked micro-
phones)
3 mixed Dante outputs

Direct

Bypass most DSP and route your audio channels directly.

Automixer and AEC are disabled
Mute behavior is Local-Individual (microphones mute/unmute indepen-
dently from each other)
All DECT mics output on individual Dante channels

Custom

Set your own audio and routing parameters in the control software.

Enable or disable audio sources and DSP options
Establish input/output routing using the Matrix Mixer

Note: In Custom mode, no Matrix Mixer crosspoints are pre-selected, and all audio input/out-
put routing is user-selectable.

Audio I/O
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Audio Inputs

Presentation Mode Conference Mode Direct Mode

Mic Input 1 & 2 
(Direct)

Direct audio input from corresponding microphone

Analog Input (Di­
rect)

Direct audio input from analog 
audio source

Direct audio input from ana-
log audio source
Can be configured as AEC 
reference

Direct audio input from analog 
audio source
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Presentation Mode Conference Mode Direct Mode

Automix Audio source created internally by the automixer

Dante Input 1 Dante-enabled audio source

Dante Input 2
Dante videoconference connection
Receive audio from participants of a video call

Dante-enabled audio source

USB Input
Can connect to far-end output of videoconferencing system via 
USB audio connection.

Audio input from any USB audio 
source

Audio Outputs

Presentation Mode Conference Mode Direct Mode

Analog Output 1
Full audio mix
Sound reinforcement for local mics
Hear participants of a video conference

Direct audio output from Mic 1

Analog Output 2
Videoconference far end only
Hear participants of a video conference

Direct audio output from Mic 2

Dante Output 1
Full audio mix
Sound reinforcement for local mics
Hear participants of a video conference

Direct audio output from Mic 1

Dante Output 2
Videoconference far end only
Hear participants of a video conference

Direct audio output from Mic 2

Dante Output 3
Local mix only
Send local audio from automixer to far-end participants

Direct audio output from Analog 
Input

Dante Output 4 N/A
Direct audio output from Automix-
er

USB Output
Local mix only
Send local audio from automixer to far-end participants

Matrix mix output from Mic 1, Mic 
2, and Analog In

Backchannel
Enhanced listening to all audio (for accessibility, etc.)
Available on each microphone using USB-C audio

AEC Reference Far end only Far end + Analog input* Dante-enabled audio source
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Presentation Mode Conference Mode Direct Mode

Reference for echo cancelling al-
gorithm

Reference for echo can-
celling algorithm
Analog reference audio (e.g. 
speakers used for far-end au-
dio)

* Analog input usage is set from the Inputs tab of the control software

Getting Started with MXW neXt 4/8
MXW neXt 4 and MXW neXt 8 are complete solutions for meeting room and presentation applications. The MXW neXt access 
point (APX) adds analog, wireless, USB audio, and Dante digital audio by Audinate to your installation, allowing you to route 
audio over standard IP equipment across a network of access points, digital-to-analog converters, and computers. RF coordi-
nation is automatic and continuous, offering worry-free wireless audio transmission for every event.

Connecting the Hardware
Connect the APX's RJ45 Port 1 to a Power over Ethernet (PoE) capable network switch to turn on the device. The 
LEDs on the front panel illuminate as the APX turns on.

When the APX has finished booting up, the Power and System LEDs light up green, and the Link LED lights up yellow.
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4.

Connect the NDX’s power supply to the USB-C connector on the back of the unit. Plug the power supply into the wall. 
Then press and hold the power button until the Power LED on the top face lights up. When the NDX has finished boot-
ing, the Power LED remains green and the link LEDs for each docking bay light up yellow.

Place microphones in the docking bays of the NDX. When docked successfully, the microphones will turn on, and the 
battery LEDs on the NDX will illuminate. The microphone displays will also show the charging status.
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Updating Firmware
After connecting your hardware to the same Ethernet network on the same local subnet, install the latest firmware update using 
the Shure Update Utility (www.shure.com/suu). Connect your computer to the same network and subnet, and dock any micro-
phones in your docking station.

CAUTION! Ensure the device has a stable network connection during the update. Do not turn off any device until the update is 
complete.

Associating NDX Bays with APX Audio Channels
NDX bays charge docked microphones and, when associated with an audio channel on the APX, can Link a wireless micro-
phone to that APX audio channel.

Before mics can be wirelessly linked to the APX, the APX needs to know which NDX it should communicate with when linking 
mics. This can be done using Shure Designer or, when a single APX and a single NDX are connected to a local subnet, by sim-
ply long-pressing the Link button on the NDX.

Connect your APX and NDX to the same Ethernet network on the same local subnet.

Important: Make sure no other APXs and NDXs are connected on the same network. The association will fail if another 
APX is on the same subnet.

Tip: One way to easily do this is to connect both devices to a dedicated switch (making sure the port connected to the 
APX supports PoE).

Press and hold the Link button on the NDX until Link LEDs on the NDX and the APX flash yellow, and then rapidly flash 
yellow. Release the button. If the association is successful, the Link LEDs on both devices turn off.

https://www.shure.com/en-US/products/software/designer_software
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The charging bays in the NDX are now associated with the matching wireless audio channel on the APX

Linking Microphones
Note: This must be done after associating NDX bays with APX channels.

With microphones docked in the NDX, press and hold the Link button on the NDX for approximately 3 seconds. The link 
LEDs on the NDX will slowly blink green.
Once the LEDs start blinking rapidly, release the Link button. Once the mics are linked, the Link LEDs on the APX and 
NDX will be solid green.

The mics are now linked to the APX on the APX channel corresponding to the docking bay that the mic was linked in, and your 
MXW neXt 4/8 system is ready to pass audio.

Operation Modes
The APX has four operation modes, which change the audio routing and mic muting behavior. To change between the different 
operation modes:

Open the Shure Update Utility on a connected computer and double-click the APX's IP address to open the device web 
application.
Create or enter a device password (if applicable).
Use the dropdown menu to set the operation mode.

Mode Details

Presentation

Share your presentation with local sound reinforcement, with a variety of 
mixed outputs.

Automix and AEC are enabled
Mute behavior is Local-Individual (microphones mute/unmute indepen-
dently from each other)
3 mixed Dante outputs

https://www.shure.com/en-US/products/software/shure_update_utility
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Mode Details

Conference

Connect to your preferred videoconferencing software.

Automix and AEC are enabled
Mute behavior is USB Mute Sync (mute state, controlled by microphones 
or external conferencing software, is applied universally to all linked micro-
phones)
3 mixed Dante outputs

Direct

Bypass most DSP and route your audio channels directly to individual 
Dante outputs.

Automixer and AEC are disabled
Mute behavior is Local-Individual (microphones mute/unmute indepen-
dently from each other)
All wireless mics output on individual Dante channels

Custom

Set your own audio and routing parameters in the control software.

Enable or disable audio sources and DSP options
Establish input/output routing using the Matrix Mixer

Note: In Custom mode, no Matrix Mixer crosspoints are pre-selected, and all audio input/out-
put routing is user-selectable.

Audio I/O
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Audio Inputs

Presentation Mode Conference Mode Direct Mode

Mic Input 1-4* / 
1-8  (Direct)✝ Direct audio input from corresponding microphone

Automix Audio source created internally by the automixer

Dante Input 1
Summed with the Automix input and sent to Dante Output 3 or 
USB Output
Intended for adding other near-end audio to the automix output

Audio input from Dante device

Dante Input 2 Intended for far-end audio, as an alternative to USB input Audio input from Dante device

USB Input
Intended for far-end output of videoconferencing system via USB 
audio connection.

Audio input from any USB audio 
source

Audio Outputs

Presentation Mode Conference Mode Direct Mode

Analog Output

Full audio mix
Sound reinforcement for local 
mics
Hear both local and remote par-
ticipants in a video conference

Far end audio only
Hear remote participants in a 
video conference

Sum of all Mic Inputs + Dante In-
put 2 + USB Input

Dante Output 1
Full audio mix
Sound reinforcement for local mics
Hear participants of a video conference

Direct audio output from Mic In-
put 1

Dante Output 2
Videoconference far end only
Hear participants of a video conference

Direct audio output from Mic In-
put 2

Dante Output 3
Local mix only
Send local audio from automixer to far-end participants

Direct audio output from Mic In-
put 3

Dante Output 4* / 
4-8✝ N/A

Direct audio output from corre-
sponding Mic Input

Dante Output 5* / 
9✝ N/A Mix of all Mic Inputs

USB Output
Local mix only
Send local audio from automixer to far-end participants

Matrix mix output from Mic Inputs 
and Dante Inputs
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•
•
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Presentation Mode Conference Mode Direct Mode

Backchannel
Enhanced listening to all audio (for accessibility, etc.)
Available on each microphone using USB-C audio

AEC Reference
Far end only
Reference for echo cancelling algorithm

* APX4

 APX8

APXD2 2-Channel Access Point Dock
MXW neXt 2 is an all-in-one wireless microphone system featuring the APXD2, which combines a 2-channel wireless trans-
ceiver, digital audio processing and two charging bays into a convenient tabletop device. On-board Dante, analog and USB au-
dio connections enable local sound reinforcement and video conferencing applications in either standalone or networked instal-
lations.

The front panel includes at-a-glance indicators and touch-sensitive buttons to facilitate quick out-of-the-box setup and intuitive 
system use, without the need for additional screen-based user interfaces. In networked installations, a computer can remotely 
control and monitor connected units via the built-in network interface.

Features
Standalone and networked installations
Front panel user interface for simple setup and intuitive use
Audio I/O: analog, Dante, USB
Built-in audio DSP: Automixer, Echo Cancellation, Noise Reduction
Dual RJ45 ports to separate audio and control traffic (3 modes)
Two built-in charging bays for wireless microphones

✝
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◦
◦

APXD2 Hardware Callouts

Front Panel

① Docking Bays
Connect and charge up to two MXW neXt handheld, bodypack, or boundary microphones.

② Link Button
Press and hold to link docked microphones. Microphones are successfully linked when the link LED stops flashing and the 
microphone display confirms successful link.

Note: Pressing the Link button when mics are present in the charging bays will overwrite any previously-linked microphones.

③ Battery LED
Indicates charging status for docked microphone.

④ Link Indicator LED
Illuminates when the audio channel associated with the charging bay is linked to a wireless transmitter (even if linked trans-
mitter is powered off).

⑤ Audio Signal Strength LED (sig/clip)
Indicates audio signal strength for each channel:

Green = Normal
Amber = Strong
Red = Clipping (to eliminate clipping, attenuate the signal level at the audio source)

Note: The bottom LED for each channel indicates the status of the connected microphone, e.g. Green = active, Red = mute, Off = inactive

⑥ Mode Indicator
Shows the selected preset mode.

⑦ Bluetooth Button
Connect or disconnect devices when Bluetooth Device Information Service (DIS) is enabled.
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⑧ Mode Selector
Selects a preset operation mode:

Mode Details

Presentation

Share your presentation, with the option of adding a third audio source

Automix and AEC are enabled
A wired microphone can be connected to the line-level analog input for a 
three-mic setup

Conference

Connect to your preferred videoconferencing software

Automix and AEC are enabled
If far-end audio is connected directly from the VC device to a loudspeaker 
(e.g. via HDMI to a room TV), connecting the analog audio input to the 
loudspeaker's analog audio signal provides reference audio for internal 
echo cancellation

Direct
Bypass most DSP and route your audio channels directly (Automix and 
AEC are disabled)

Custom

Set your own audio parameters in the control software

Enable or disable audio sources and DSP options
Establish input/output routing using the Matrix Mixer

Back Panel

① Analog Audio Input
Balanced* audio input connects to an analog audio device. Set the analog input level to match the output level of the ana-
log device.

Input sensitivity:

Line (+4 dBu)

Aux (-10 dBV)
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② Chassis Ground Screw
Provides an external connection point to the chassis ground of the device.

③ Analog Audio Output
Balanced* audio output connects to a signal processor, amplifier, or recording system. OUT1 provides the full mix (all audio 
inputs), OUT2 provides mix-minus (far-end audio inputs only, minus local audio).

④ Locking USB-C Audio Connector
Connect to a laptop, videoconferencing unit, or control device.

⑤ Power Connector
Locking USB-C power connector. To ensure reliable operation of the product, use only with the included 5V 3A power sup-
ply, or a Shure-approved equivalent.

If any other power supply is used, a continuous, stabilized supply of minimum 5V 3A is required for reliable operation.

⑥ Ethernet Ports
Connect to Dante audio network, external control software.

⑦ Kensington Lock Connection Point
Provides a secure anchor for attaching an anti-theft security cable.

⑧ Reset Button
Press and hold for 5-8 seconds to reset network settings.

Press and hold for more than 8 seconds to reset the device to factory default settings.

* For unbalanced connections, only use pins 1 (signal) and 3 (ground) of the block connector.

APX4/APX8 Access Point
MXW neXt APX4 and APX8 access points feature 4 or 8 wireless audio channels, on-board analog, Dante, and USB-C audio 
connections, and IntelliMix functionality. Integration with additional MXW neXt hardware enables all-in-one monitoring and con-
trol tailored to your specific application. Integration with additional MXW neXt hardware and Shure Designer software enables 
all-in-one monitoring and control tailored to your specific application.

https://www.shure.com/en-US/products/software/designer_software
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APX Hardware Callouts

① Power LED
Indicates power status and system states, including system reset.

② Audio OUT LED
Indicates when any of the audio outputs is carrying an active audio signal.

③ Link LED
Indicates link status of wireless microphones.

④ System LED
Indicates whether the device is operating normally.

⑤ Reset Button
Press and hold for 5-8 seconds to reset network settings.

Press and hold for more than 8 seconds to reset the device to factory default settings.

⑥ Cable Routing Path
Provides a path for Ethernet cables to enable a flush-mount to the ceiling or wall.
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(Recommended mounting screws: PA4 × 10)

⑦ RJ45 Connectors
Compatible with Ethernet connections (switched, split, or redundant networking) and Dante audio devices. Port 1 provides 
PoE input to power the APX.

⑧ Locking USB-C Audio Connector
Supports USB audio input and output.

⑨ Analog Audio Output
Block connector for a balanced analog audio signal.

⊕ (Audio +)

⊖ (Audio -)

⏚ (Audio ground)

⑩ Chassis Ground Screw
Provides an external connection point to the chassis ground of the device.

APX LED Behavior
Customize LED behavior from Settings > Lights.

Event Event State LED

Boot

In progress Green

Complete Green

Error Red

Firmware update In progress
Red-Amber-
Green (Cycle)

Reset
In progress (network) Amber (Flash)

In progress (factory) Green (Flash)

NDX association

Unassociated Amber

In progress

Amber (Strobe)

Turns off when 
complete

Association error Red (Flash)

Identify In progress Amber (Flash)

Audio metering In progress Dynamic

Link/Unlink microphone In progress Green (Strobe)
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Event Event State LED

Complete (Link) Green

Complete (Unlink) Off

Link error Red (Flash)

Spectrum scan In progress
Red/Green (Cy-
cle)

NDX4/NDX4G/NDX8/NDX8G Networked Docking Station
NDX4/8 and NDX4G/8G networked docking stations can charge 4 or 8 transmitters without removing the battery, link micro-
phones to wireless audio channels on associated access points, and share battery status with networked control software. In-
tegration with additional MXW neXt hardware enables all-in-one monitoring and control tailored to your specific application. In-
tegration with additional MXW neXt hardware and Shure Designer software enables all-in-one monitoring and control tailored 
to your specific application.

NDX4 and NDX8 are compatible with bodypack, handheld, and boundary microphones, NDX4G and NDX8G are compatible 
with boundary and gooseneck microphones.

NDX Hardware Callouts

https://www.shure.com/en-US/products/software/designer_software
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① Docking Bays
Connect and charge MXW neXt microphones:

NDX4 / NDX8: 4 or 8 handheld, bodypark, or boundary microphones
NDX4G / NDX8G: 4 or 8 boundary or gooseneck microphones

② Link Button
Press and hold to link docked microphones. Microphones are successfully linked when the link LED stops flashing and the 
microphone display confirms successful link.

Note: Pressing the Link button when mics are present in the charging bays will overwrite any previously-linked microphones. Lock the Link button from the 
Settings pane of the control software.

③ Power LED
Indicates that the networked docking station is connected and powered on.

④ Battery LED
Indicates charging status for docked microphone.

⑤ Link Indicator LED
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Indicates whether a bay is associated with an audio channel, and whether a microphone is linked to that channel.

⑥ Ethernet Ports
Connect to an access point to associate charging bays with wireless audio channels and enable advanced monitoring and 
control. Daisy-chain up to 5 networked networked docking stations to reduce Ethernet port requirements and cabling.

⑦ Power Connector
Locking USB-C power input. To ensure reliable operation of the product, use only with the included USB-C PD power sup-
ply, or a Shure-approved equivalent.

If any other power supply is used, a USB-C PD supply that can output 15V 3A is required for reliable operation.

⑧ Reset Button
Press and hold for 5-8 seconds to reset network settings.

Press and hold for more than 8 seconds to reset the device to factory default settings.

⑨ Power Button
Powers networked docking station on or off.

Note: Power button state persists through device power cycle.

NDX LED Behavior
Customize LED behavior from Settings > Lights.

Event Event State LED

Boot

In progress Green

Complete Green

Error Red

Firmware update In progress
Red-Amber-
Green-Amber 
(Cycle)

Reset
In progress (network) Amber (Flash)

In progress (factory) Green (Flash)

Charge mics In progress
Red-Amber-
Green (Charge 
status)

Identify In progress Amber (Flash)

APX association

Unassociated Amber

In progress

Amber (Strobe)

Turns off when 
complete
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Event Event State LED

Association error Red (Flash)

Link/Unlink microphone

In progress Green (Strobe)

Complete (Link) Green

Complete (Unlink) Off

Link error Red (Flash)

MXW neXt Microphone Transmitters
MXW neXt microphones transmit an encrypted, wireless audio signal to the access point. Four form factors are available:

Hybrid Bodypack (MXW1X)

The bodypack secures to a belt or strap for hands-free, mobile communication. It features a TQG input for lavalier connec-
tion and an integrated omnidirectional microphone.

Handheld (MXW2X)

The handheld enables presenters to communicate using legendary Shure SM58, SM86, BETA58 and VP68 microphone 
cartridges.

Boundary (MXW6X/C, MXW6X/O, MXW6XW/C, MXW6XW/O)

The boundary transmitter sits on a table or desk to transmit speech while discreetly blending into any conference environ-
ment.

Desktop Gooseneck Base (MXW8X, MXW8XW)

The gooseneck base is compatible with 5", 10", and 15" Microflex gooseneck microphones.

To charge a gooseneck base using an APXD2, use a USB cable to connect the charging port of the microphone to the USB plug in the docking bay.
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Microphone Hardware Callouts
① Mute/Active Button

Changes the audio status from Active to Mute, or Mute to Active. Button behavior for some transmitter types can be set in-
dependently from the Preferences tab of the control software.

Note: For MXW1X and MXW2X, press and hold the Mute/Active button for 5 seconds to turn the transmitter off. Short press the Mute/Active button to turn the 
transmitter on.

② Status LED
Indicates the transmitter's status. The color indicators for Mute and Active can be customized from the Preferences tab. See 
the Status LED table for the default LED behavior for MXW neXt transmitters.

Note: Gooseneck microphones have either an LED ring at the base, or an additional LED at the top. These can be configured independently to indicate addi­
tional status information.

③ Display
Shows receiver and transmitter settings and information, including battery and RF status, microphone and base unit name, 
and menu options.

④ USB-C Connector
Connects to the docking station or USB charger. Can be used with the Shure AMXWX-USBC-3.5mm adapter dongle to pro-
vide a headphone output.

⑤ Microphone
MXW1X hybrid bodypack has a TQG connector for an external lavalier or headset microphone, as well as an internal micro-
phone.

MXW2X handheld transmitter is compatible with SM58, Beta 58, SM86, and VP68 cartridges.

MXW6X features an internal microphone, available with cardioid or omnidirectional microphone cartridges.
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MXW8X gooseneck base is compatible with 5", 10", and 15" Microflex gooseneck microphones.

⑥ + / - Buttons (MXW1X)
Adjusts the MXW1X back-channel audio volume when a headphone is connected. Also selects between internal and exter-
nal microphone: press and hold both buttons, use the + / - to select the desired input on the display, then press and hold 
both buttons to confirm selection.

⑦ Power On/Off (MXW6X, MXW8X)
Press and hold the dedicated power button for 3 seconds to turn the transmitter on or off.

Note: For MXW1X and MXW2X, press and hold the Mute/Active button for 5 seconds to turn the transmitter off. Short press the Mute/Active button to turn the 
transmitter on.

MXW-X Microphone LED Behavior

Status LED Description

Active Green* Ready to pass audio to network.

Mute Red* Audio is muted.

Initializing / acquiring RF 
channel

Red / Green (Alternating)

The transmitter is initializing and acquiring the RF connec-
tion to the linked access point.

Standard density mode has a slow alternating rate.
High density mode has a fast alternating rate.

Out of range Red (Flash)
The transmitter is outside the RF coverage range of the 
linked access point.

Charging Off The transmitter is charging.

Off Off
No connection to the network. The transmitter must be 
turned on using the power button on the mic.

* Default behavior. Customize LED behavior from Settings > Lights.

Rechargeable Batteries for MXW neXt Portables
MXW neXt lithium-ion rechargeable batteries use advanced chemistry that maximizes transmitter runtime. Power management 
from the control software provides detailed visibility to critical battery parameters such as charge status and battery life.

Battery: SB906

Transmitter: MXW1X bodypack
Transmitter: MXW6X boundary

Battery: SB908

Transmitter: MXW2X handheld
Transmitter: MXW8X gooseneck base

Charge Status LEDs
Each docking bay has a Charge LED that illuminates to indicate the charging status for the docked microphone:
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Charging Status LEDs

Color State

Green >4 hours of runtime

Yellow 2-4 hours of runtime

Red <2 hours of runtime

Off Microphone is not inserted into the charging bay, or power supply is not connected

Additional LED states are defined under NDX LED Behavior.

Maximizing Battery Life
While the rechargeable Li-Ion batteries for MXW1X and MXW6X transmitters are designed to last up to 17 hours or more on a 
charge, and MXW2X up to 39 hours, variance in battery health and use-case may result in significant differences in battery run-
time. Specifically, consistency and overall runtime decrease with the number of charge cycles. Battery health of 80% or less is 
an indicator that a battery is nearing or at the end of its designated life cycle and should be replaced. Health percentage and 
number of charge cycles are available from the Settings tab of the MXW neXt control software.

High Density Mode
High Density (HD) mode reallocates system resources to create additional channels when needed. In applications where laten-
cy and back-channel audio monitoring aren't major considerations, switching to HD mode can also provide up to an hour of ad-
ditional battery runtime.

Density mode is set from the Settings tab of the MXWAPX control software.

Battery Replacement
Lithium Ion Batteries experience a linear reduction in capacity. Shure recommends establishing a battery replacement sched-
ule customized to the client requirements and replacing batteries when the capacity is no longer acceptable.

Important: After installing a new battery, reset the battery health statistics that are stored in the microphone following the steps 
in Reset the Microphone Battery Statistics in the previous section.

MXW1X, MXW6X, MXW8X Battery Replacement
Unscrew and open the battery door on the bottom of the transmitter.
Remove battery by gently disconnecting the battery connector from the transmitter.
Connect the replacement battery's connector to the transmitter.
Replace the battery with the label facing out.
Close the door and tighten the screw.
Dispose of batteries properly. Check with your local vendor for proper disposal of used batteries.

MXW2X Battery Replacement
MXW2X batteries should be replaced by qualified service personnel only.
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Linking MXW neXt Microphones to Channels
Place an MXW neXt microphone transmitter into a connected docking bay and press the Link button. This links the microphone 
to the audio channel associated with that docking bay.

MXW neXt 4- and 8-channel systems use associated NDX networked docking stations to establish the link between the 
microphone transmitter and the APX audio channel.
MXW neXt 2 systems automatically associate the bay number with the corresponding audio channel number.

To exchange transmitters, follow the same procedure: place the new transmitter in the docking bay that corresponds to the de-
sired channel and press the Link button. This maps the new transmitter to that channel, overwrites any previously-established 
Links.

Note: Lock the Link button from the Settings pane of the control software.

Note: If a docking bay is empty during the Link procedure, that channel remains unaffected. This means a devices on one channel can be exchanged without 
interrupting the audio on the active channel.

Associating Microphones with APX Audio Channels
Before linking microphones in MXW neXt 4/8 systems, associate NDX docking bays with corresponding APX audio channels. 
This can be done using Shure Designer software, or, when a single APX and a single NDX are connected to a local subnet, by 
long-pressing the Link button on the NDX.

The LEDs on the NDX indicate association status:

Amber (solid): Bay is not associated with an APX audio channel.
Amber (flashing): Association in progress.
Off: Bay is associated with an audio channel, but no microphone is linked.
Green: Associated audio channel is linked to a microphone.

MXW neXt Control Software
There are 2 ways to control MXW neXt systems:

Option 1: Use Shure Designer software
Control all Shure devices in one place
Route audio to and from Shure devices

Option 2: Access the MXW neXt web application with Shure Update Utility
Control 1 device at a time
Route audio with Dante Controller software

Control MXW neXt Devices with Shure Designer Software
To control this device's settings, use Shure Designer software. Designer enables integrators and system planners to design au-
dio coverage for installations using MXW neXt systems and other Shure networked devices.

To access your device in Designer:

Download and install Designer on a computer connected to the same network as your device.
Open Designer, and check that you’re connected to the correct network in File > Designer preferences.
Click Online devices. A list of online devices appears.
To identify devices, select a device and click ID in the Properties menu. Double-click the device to open the settings.

https://www.shure.com/en-US/products/software/designer_software
https://www.shure.com/suu
https://www.audinate.com/products/software/dante-controller
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From here, you can add devices to rooms and route audio to other Shure devices. Learn more at shure.com/designer.

Note: Designer support for MXW neXt is restricted to online rooms.

Designer Setup Example
This example uses Designer to connect an MXWNDX4 and an MXWAPX8 in an Online Room. The process is similar when us-
ing other combinations of devices in Designer, so use these steps as a starting point.

After completing this basic setup process, you should be able to:

Discover the MXWAPX and MXWNDX in Designer
Adjust DSP settings and route audio
Understand the basic workflow for working with devices in Designer

This example uses:

Cat5e (or better) Ethernet cable (shielded cable recommended)
Network switch or computer that provides Power over Ethernet (PoE)
Shure Designer software installed on a computer (download at shure.com/designer)

Step 1: Install and Connect
Install the devices in your room. Connect the MXWAPX Port 1 to PoE, and connect Port 2 to the MXWNDX using Eth-
ernet cables.

Connect your computer running Designer to the same network as your devices.
Open Designer. Check that you’re connected to the correct network in File > Designer preferences.
Click File > New online room and drag your devices into the online room.

http://www.shure.com/designer
https://www.shure.com/designer
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Step 2: Route Audio
The easiest way to route audio and apply DSP is with Designer's auto route feature. This feature automatically routes audio 
signals, applies DSP settings, turns on mute synchronization, and enables LED control for connected devices.

Select Auto route. Designer will route occupied MXWNDX docking bays with the corresponding MXWAPX audio chan-
nels.

You can also route audio manually in Designer or with Dante Controller.

Check the audio routes, matrix mixer routes, and other settings to make sure they fit your needs. You might need to:
Delete unnecessary routes.
Verify that AEC reference signals are correctly routed.
Fine-tune DSP blocks as needed.
Check matrix mixer routes.

Send audio from the APX to other sources using the matrix mixer. A common destination is a computer connected by 
USB with videoconferencing software.
Select Deploy and connect to send device settings to your installed online devices. Designer walks you through associ-
ating the design devices with the online devices.
Add coverage, if needed.

Go to [Your room] > Coverage
Select your device and go to Properties > Coverage > Add coverage.

Use Designer's Auto Route
Designer's auto route speeds up the process of connecting systems with 1 audio processor and at least 1 microphone. Auto 
route also creates mute control routes in rooms with MXA network mute buttons. When you select Auto route, you can direct 
Designer to:

Create audio routes and mute control routes
Adjust audio settings
Turn on mute synchronization
Enable LED logic control for applicable devices

The settings are optimized for your particular combination of devices. You can adjust settings further, but auto route gives you a 
good starting point. Auto route works with any device in Designer.
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To use auto route:

Place all relevant devices in a design.
Select Auto route. Designer optimizes microphone and DSP settings for your equipment combination.

If you remove or add devices, select Auto route again.

Note: The auto route process clears any manual routes you may have made in your design.

After auto routing a room, check and adjust settings to fit your needs. You may need to:

Delete unnecessary routes.
Check levels and adjust gain.
Check that AEC reference signals are correctly routed and received in a test call.
Fine-tune DSP blocks.
Adjust your processor's matrix mixer routes.

If you want to auto route an online room, turn on online room editing in File > Designer preferences.

Note: Changes to an online room may cause audio to briefly drop out.

Refer to Designer's Troubleshooting section for help with routing.

MXW neXt Web Application
The MXW neXt control software allows comprehensive system control and monitoring from a computer. It is hosted from an 
embedded server in the access point, and is accessible when properly networked to a computer. All hardware functions can be 
adjusted using this software interface.

When logging in for the first time, you can set a password to restrict access, or choose to continue with no password. Set or 
change the password from Settings > Permissions.

Note: For optimal system performance, the control software should not be open to more than seven tabs or windows.

Open the MXW neXt Control Software
Access the MXW neXt control software from any computer on the MXW neXt network. The software is hosted from a webserv-
er embedded in the MXW neXt devices.

Connect your computer to the MXW neXt device

The computer accesses the control software from an embedded web server on the device. All networked devices must 
be connected via Ethernet cable, or wirelessly to the same network (set to the same subnet).

Note: For wired connections, turn off the computer's WiFi to force the wired network interface.

Install and open the Shure Update Utility

Download and install the Shure Update Utility from shure.com/SUU. Open the application to view Shure devices on the 
network that use an embedded server for control software, such as your MXWAPX device. You can use the Identify but-
ton to flash a device's LEDs for easy identification.

Open the MXW neXt Control Software

From the Shure Update Utility, double-click the IP address of an MXW neXt device to open the MXW neXt System con-
trol software. The application can be set to open by IP address or DNS name (selectable from the Preferences drop-
down).

Bookmark the Webpage (recommended)

https://pubs.shure.com/guide/Designer/en-US#c_07601b9f-5da8-414d-a01b-9f5da8214d19
https://www.shure.com/suu
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Bookmark the IP address of the device when it is set to a Static IP address. Bookmark the device's DNS name when 
the IP mode is set to Automatic (DHCP).

Open the Web Application with HTTPS
This device’s browser-based web application uses an HTTPS connection for confidentiality and authenticity. HTTPS encrypts 
information sent between the device and the web application.

To open the web application:

Open Shure Update Utility and check that you're connected to the same network as the device.
Double-click the device's IP address to open the web application in your browser.
The web application uses self-signed certificates. You may see a warning message in your browser the first time you 
open the web application. Click Advanced and select the option to trust the connection.

To control HTTPS settings, go to Settings > Services in the web application.

For more help, refer to our step-by-step video about HTTPS web applications.

Available in firmware 3.0 and newer

MXW neXt Schematic View
The MXW neXt Control Software opens by default to the Schematic view.

① Global Settings
Mute all channels, change the operation mode, or customize the device name. Identify a de-
vice by clicking the logo next to the device name.

② Inputs The connected input channels, device names, and input digital signal processing (DSP).

③ Automixer
Input channels are routed to the automixer, which gives an additional "automix out" audio 
track.

④ Direct Channels
Independently adjust gain and mute status from the Direct Channels tab. Allows multiple 
mixes to be sent to different outputs (e.g. provide sound reinforcement for videoconferenc-
ing, while excluding that microphone from the local mix to avoid feedback).

https://www.shure.com/suu
https://youtu.be/auP6gcGh8SQ?si=HOEdtPhBr2b_ASTc
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⑤ Digital Signal Process­
ing

Indicates DSP settings applied to the direct channels and automix out.

⑥ Matrix Mixer Multiple input channels can be routed to multiple output channels.

⑦ Outputs The available output channel names, numbers, and output DSP.

⑧ Settings Open the global Settings menu.

MXW neXt Inputs Screen

① Input Channel
Shows whether the channel is associated with a wireless, analog, Dante, USB, or return au-
dio source. The channel name is customizable, and is independent from the microphone 
linked to that channel.

② Microphone Type Indicates the microphone type and customizable device name.
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③ RF Meter Indicates the average RF signal quality for wireless input devices.

④ Battery Meter Displays estimated battery information for wireless input devices.

⑤ Channel Status Select whether connected wireless input devices are active or inactive.

⑥ Digital Signal Process­
ing (DSP)

Configure and apply parametric equalizer (PEQ) and automatic gain control (AGC) to the au-
dio input signal.

⑦ Gain Control Set the output gain using the slider, or adjust the gain in + / - 0.1 dB increments.

⑧ Audio Output Meter Indicates the average output signal level.

⑨ Mute Mute or unmute the audio channel.

⑩ Link / Unlink

Link* or unlink wireless microphones from input channels and determine input source infor-
mation.

* Microphones placed in a docking bay can be linked to the associated channel.

⑪ Input Source Remotely switch between the internal and external microphone.

⑫ Properties Pane Expand to view global properties for all output channels.

⑬ Input Metering Determine whether the input level is measured pre- or post-gain.

Parametric Equalizer (PEQ)
Maximize audio quality by adjusting the frequency response with the parametric equalizer (PEQ). Use the input equalizers to 
make adjustments to specific channels, while using the output equalizers to adjust frequency response of all signals that are 
summed through a given output.

Adjust filter settings by manipulating the icons in the frequency response graph or by entering numeric values.
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Filter Type

Parametric: Attenuates or boosts the signal within a customizable frequency range

Low Cut: Rolls off the audio signal below the selected frequency

Low Shelf: Attenuates or boosts the audio signal below the selected frequency

High Cut: Rolls off the audio signal above the selected frequency

High Shelf: Attenuates or boosts the audio signal above the selected frequency

Frequency
Select the center frequency of the filter to cut/boost.

Gain
Adjusts the level for a specific filter (+/− 18 dB).

Q
Adjusts the range of frequencies affected by the filter. As this value increases, the bandwidth becomes thinner.
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Width
Adjusts the range of frequencies affected by the filter. The value is represented in octaves.

Note: The Q and width parameters affect the equalization curve in the same way. The only difference is the way the values are represented.

Automixer
This channel automatically mixes the audio from all selected channels to a single output. Customize settings to fit your installa-
tion under the Properties pane.

To use the automix channel:

Check that Mute is turned off for all channels. Any channels muted on the Automixer tab are excluded from the mix.
Route the automix channel in Designer or Dante Controller.

MXW neXt Automixer Controls

① Input Channel The channel for the connected input device.

② Gain Control Set the output gain using the slider, or adjust the gain in + / - 0.1 dB increments.

③ Audio Meter Indicates the average audio signal.

④ Mute Button Mutes or unmutes the channel's audio.
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⑤ Automix Channel The automix output channel.

⑥ Output DSP (Digital Sig­
nal Processing)

Configure and apply automatic echo cancellation (AEC), noise reduction (NR) and paramet-
ric EQ (PEQ) to the automix output channel.

⑦ Properties Pane Expand to view global properties for all output channels.

Automix Modes
Select an automix mode under Automixer > Properties.

Gating
Gating mode delivers fast-acting, seamless channel gating and consistent perceived ambient sound levels. The off attenuation 
setting is applied to all inactive channels, regardless of the number of active channels.

Gain Sharing
Gain sharing mode dynamically balances system gain between open and closed channels. The system gain remains consis-
tent by distributing gain across channels to equal one open channel. The scaled gain structure helps to reduce noise when 
there is a high channel count. When fewer channels are used, the off attenuation setting is lower and provides transparent gat-
ing.

Manual
Manual mode sums all active tracks and sends the summed signal over a single Dante output. This provides the option to route 
an individual signal for reinforcement or recording, without enabling automixing. The settings from the faders in the standard 
monitoring view apply to the summed output.
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MXW neXt Direct Channels Tab

① Direct Input Channels The channel for the connected MXW neXt microphone.

② Analog Input Channel The channel for the connected analog input device, if available.

③ Channel Status Indicates whether the channel is active.

④ Direct Out Tap Point
Determine whether the channel audio is taken Pre-gate (direct audio, no level adjustments) 
or Post-gate (after Automix level adjustments).

⑤ Input EQ Configure and apply parametric EQ (PEQ) to input channels.

⑥ Gain Control Set the output gain using the slider, or adjust the gain in + / - 0.1 dB increments.

⑦ Audio Meter Indicates the average audio signal.

⑧ Mute Button Mutes or unmutes the channel's audio.



Shure Incorporated

45/84

MXW neXt Audio Outputs

① Output Channel
Shows whether the channel is associated with an analog, Dante, USB, or backchannel out-
put.

② Device Name
Customize device names for RF and Audio channel identification. The name is associated 
with the channel on the APX, will be stored on it, and is independent from the microphone 
linked to that channel.

③ Digital Signal Process­
ing (DSP)

Configure and apply parametric equalizer (PEQ) to the output channel.

④ Gain Control Set the output gain using the slider, or adjust the gain in + / - 0.1 dB increments.

⑤ Audio Output Meter Indicates the average output signal level.

⑥ Mute Mute or unmute output channels.

⑦ Analog Output Level Change the output level for analog audio sources.

⑧ Properties Pane Expand to view global properties for all output channels.

⑨ Output Metering Determine whether the output level is measured pre- or post-gain.

Battery Monitoring and Statistics
Use the APX and NDX web apps to manage battery information.
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APX Inputs Tab
Use the Inputs tab of the MXWAPX web app to view battery status and remotely control the power setting for connected micro-
phones.

On Charger
Displays the remaining time until the microphone battery is fully charged.

In Use
Displays the remaining battery runtime of the microphone, if available.

NDX Home Screen
Monitor battery and link status for docked microphones from the MXWNDX web app.

MXW neXt Web App Settings
Open the Settings pane to modify system and device settings, including microphone preferences, IP configuration, audio en-
cryption, cloud connectivity and button/LED behavior, or to factory reset your device.
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General Settings

① Operation Mode Select the preset operation mode: Presentation, Conference, Direct, or Custom.

② Device Name Device names can be customized with up to 31 characters, except '=','.' or '@'.

③ Push to Dante
Uses the device name from the MXW neXt control software to overwrite the names in the 
Dante Controller (DC) software by Audinate.

④ Dante Device Name The current device name as registered in the Dante Controller software by Audinate.

⑤ Device Model The device model number.

⑥ Language Set and apply language for the MXW neXt control software.

⑦ Serial Number
The unique identifier used to register the device at the Shure website, guarantee the warran-
ty, and troubleshooting with customer support.
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Wireless Microphone Settings

① Spectrum Scanner
Opens the spectrum scanner to estimate how many channels you can fit across your avail-
able wireless spectrum.

② RF Density Mode
Set your system to Standard (SD) or High Density (HD) modes, depending on the number of 
channels you need.

③ RF Power Set your system's RF power level.

④ Back In Range Behavior
Determine what happens when a paired microphone comes back in range of your access 
point.

⑤ Enable Out Of Range 
Alarm

Check to enable an alert when a paired microphone is disconnected.

⑥ Switch Behavior Customize the switch on each transmitter type.

⑦ Initial State from Charg­
er

Assigns the state for the transmitter after it has been removed from the charger:

⑧ Mute Preference

Set mute preferences for your devices, when available.

Mute local-individual (default): Each transmitter is muted individually. Available in 
Custom and Direct modes.
Mute local-all: All transmitters mute when any transmitter is muted. Available in Cus­
tom and Direct modes.
USB mute sync: Mute state, controlled by microphones or external conferencing soft-
ware, is applied universally to all linked microphones. Available in Custom mode.
Mute logic-follower: All channels are always muted or unmuted in the DSP that acts 
as logic leader. Available in Direct mode.
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External mute: Transmitter audio is on, and muted from a 3rd-party controller. Avail­
able in Custom and Direct modes.

IP Configuration
The MXW neXt control software coordinates IP updates across the entire system of devices. The default setting is Auto, which 
enables the devices to accept IP settings from a DHCP server, or automatically fall back to Link-Local settings when no DHCP 
is available. To manually set the IP address of an interface, select Manual. Configure the IP properties from the Settings menu:

Go to the Settings tab for the device.
After adjustments have been made, click Save.

Connecting to the APXD2 Bluetooth DIS
The APXD2 supports the Bluetooth Device Information Service (DIS). When an Android phone or tablet is connected to APXD2 
via Bluetooth, device information will appear in applications that support Bluetooth DIS. Bluetooth DIS does not pass audio. 
The APXD2 can connect via Bluetooth to one Android device at a time.

To connect to an APXD2 via Bluetooth:

In the MXW neXt control software, enable Bluetooth Device Information Service in Settings > Services.
Press and hold the Bluetooth button on the APXD2 hardware. The button flashes blue when pressed. When the button 
turns solid blue, the APXD2 is ready to pair with an Android phone or tablet.
In the Bluetooth discovery menu on your Android phone or tablet, select the APXD2 to pair with it.

Applications that support Bluetooth DIS will now display information about the APXD2.

To turn off Bluetooth on the APXD2, press and hold the Bluetooth button until the light turns off. Bluetooth turns off automatical-
ly when APXD2 is in Standby mode, is powered off, or is factory reset. As long as Bluetooth DIS remains enabled in the MXW 
neXt control software, long-pressing the Bluetooth button on the APXD2 will turn Bluetooth DIS functionality back on.
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Adjust DSP Settings
Acoustic Echo Cancellation
In audio conferencing, a far-end talker may hear their voice echo as a result of a near-end microphone capturing audio from 
loudspeakers. Acoustic echo cancellation (AEC) is a DSP algorithm which identifies the far-end signal and stops it from being 
captured by the microphone to deliver clear, uninterrupted speech. During a conference call, the AEC works constantly to opti-
mize processing while far-end audio is present.

When possible, optimize the acoustic environment using the following tips:

Reduce loudspeaker volume
Position loudspeakers farther from microphones
Avoid pointing loudspeakers directly at microphone coverage areas

Note: If the Shure system is providing AEC, it is not recommended to enable AEC anywhere else in the audio chain.

Select a Reference Signal for AEC
AEC is applied at the output channel. To set or change the reference signal, set the operation mode to Custom and route a far-
end signal to the AEC Reference output from the Matrix Mixer. For best results, use the signal that also feeds your local rein-
forcement system.

Note: Always send an AEC reference signal to microphones with AEC processing, even if you are using a separate DSP for AEC.

AEC Settings

Reference Meter
Use the reference meter to visually verify the reference signal is present. The reference sig-
nal should not be clipping.

ERLE
Echo return loss enhancement (ERLE) displays the  dB level of signal reduction (the amount 
of echo being removed). If the reference source is connected properly, the ERLE meter ac-
tivity generally corresponds to the reference meter.

Reference Indicates which channel is serving as the far end reference signal.

Non-Linear Processing

The primary component of the acoustic echo canceller is an adaptive filter. Non-linear pro-
cessing supplements the adaptive filter to remove any residual echo caused by acoustic ir-
regularities or changes in the environment. Use the lowest possible setting that is effective in 
your room.
Low: Use in rooms with controlled acoustics and minimal echoes. This setting provides the 
most natural sound for full duplex.
Medium: Use in typical rooms as a starting point. If you hear echo artifacts, try using the 
high setting.
High: Use to provide the strongest echo reduction in rooms with bad acoustics, or in situa-
tions where the echo path frequently changes.

Automatic Gain Control (AGC)
Automatic gain control adjusts channel levels to ensure consistent volume for all talkers, in all scenarios. For quieter voices, it 
increases gain; for louder voices, it attenuates the signal.
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Automatic gain control is post-fader, and adjusts the channel level after the input level has been adjusted. Enable it on chan-
nels where the distance between the talker and the microphone may vary, or in rooms where many different people will use the 
conferencing system.

Target Level (dBFS)

Represents the level that you want the gain to reach. This level is different from adjusting the input fader according to peak 
levels to avoid clipping.

Maximum Boost (dB)

Sets the maximum amount of gain that can be applied

Maximum Cut (dB)

Sets the maximum attenuation that can be applied

Tip: Use the boost/cut meter to monitor the amount of gain added or subtracted from the signal. If this meter is always reach-
ing the maximum boost or cut level, adjust the input fader so the signal is closer to the target level.

Noise Reduction
Noise reduction significantly reduces the amount of background noise in your signal caused by projectors, HVAC systems, or 
other environmental sources. It is a dynamic processor, which calculates the noise floor in the room and removes noise 
throughout the entire spectrum with maximum transparency.

Settings
The noise reduction setting (low, medium, or high) represents the amount of reduction in dB. Use the lowest possible setting 
that effectively lowers noise in the room.

MXW neXt System Connection Diagrams
The following system diagrams illustrate potential use-cases for connecting your MXW neXt system. For more help on system 
configuration, please contact your local service representative.

APXD2 Connection Overview
The APXD2 can be operated with or without a computer, and features analog, USB and Dante connections as well as wireless 
communication with paired MXW neXt microphones. Systems can be configured for sound reinforcement, videoconferencing, 
or both.
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Sound Reinforcement
Connect additional audio devices to ensure presenters can be heard clearly anywhere in the room.

Analog Out

Operation Mode: Presentation
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Dante Out

Operation Mode: Presentation

Video Conferencing
Use APXD2 to seamlessly provide high-quality audio to your chosen conferencing software.

Analog Out

Operation Mode: Conference
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Room TV

Operation Mode: Conference

APX4/8 Connection Diagrams
MXW neXt systems can be operated with or without a computer, and feature analog, USB and Dante connections as well as 
wireless communication with paired MXW neXt microphones. Built-in DSP enables direct connection to video conferencing 
systems, with optional simultaneous sound reinforcement in hybrid use cases.

Example: Sound Reinforcement
Ensure remote and in-person presenters can be heard clearly anywhere in the room.
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Note: Additional sound reinforcement configurations are possible based on available hardware and system capabilities.

Operation Mode: Presentation

Example: Video Conferencing
Enhance your conference rooms with high-quality audio for all participants.

Note: Additional conferencing configurations are possible based on available hardware and system capabilities.

Operation Mode: Conference
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Configuring Networks with MXW neXt
Networking Best Practices
Use the following best practices when setting up a network to ensure reliable communication:

Always use a "star" network topology by connecting each component directly to the switch or router.
Connect networked MXW neXt gear to the same network and set to the same subnet. This ensures best system perfor-
mance and maximum microphone count.
Use only 1 DHCP server per network. Disable DHCP addressing on additional servers.
Power on the switch and DHCP server prior to MXW neXt equipment.
To expand the network, use multiple Ethernet switches in a star topology.
Connect each device directly to the port of an Ethernet switch. Avoid "daisy-chaining" Ethernet port connections between 
devices for larger networks.
Do not loop network connections.
All devices must be at the same firmware revision level.

Digital Audio Networking
Dante digital audio is carried over standard Ethernet and operates using standard internet protocols. Dante provides low laten-
cy, tight clock synchronization, and high Quality-of-Service (QoS) to provide reliable audio transport to a variety of Dante de-
vices. Dante audio can coexist safely on the same network as IT and control data, or can be configured to use a dedicated net-
work.

Network Audio and Shure Control Data
MXW neXt devices transport two types of data over the network: Shure Control and Network Audio.

Shure Control

The Shure Control carries data for the control software operation, firmware updates and 3rd party control systems (AMX, 
Crestron). This data is transported to all MXW neXt components connected to the network.

Network Audio

This network carries both the Dante digital audio and the control data for Dante Controller. This data is transmitted be-
tween the APT, the output device and the computer. The network audio requires a wired, gigabit Ethernet connection to 
operate.

Go toSettings > IP Configuration to view and edit the IP settings for MXW neXt devices.

Manually Assigning Static IP Address
To manually assign IP addresses to the MXW neXt system, follow these steps:

Open the IP Configuration menu in the Settings tab.
Select the Manual radio button.
Enter the IP settings and click Save. The control software may close if settings have been updated for the access point.
Change the computer's IP address to match the subnet of the MXW neXt equipment.
Reopen the MXW neXt control interface.

Dante Network Audio
Connect your Dante audio network to the MXW neXt system.
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Connect a network of devices

2 input channels, useful for:

Dante-enabled microphones
Output from an automatic mixer or room system
Videoconferencing signal of far-end audio

3 output channels, useful for:

Recording system for archiving
Live-streaming events
Videoconferencing feed of near-end audio

Routing Dante Channels
Use Shure's Designer software, or Dante Controller software by Audinate , to route Dante channels in and out of the MXW 
neXt system.

Overview of Dante Network Modes
The Dante network interface has two ports (Primary and Secondary) to provide flexible routing and configuration options for 
network signals.

Three selectable Dante network modes are available to control signal routing from the receiver ports to the Dante network.

®
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Network 
Mode

Port Function and Signals
Application

Secondary Primary

SWITCHED

Shure Control

Dante Audio 
and Control

Shure Control

Dante Audio 
and Control

For single network Installations of star or daisy-chained networks.

REDUNDANT 
AUDIO

Dante Redun-
dant Audio

Shure Control

Dante Audio 
and Control

Primary and Secondary ports are configured are 2 separate networks. 
The Secondary port carries a backup copy of the Primary digital audio 
signal.

SPLIT
Dante Audio 
and Control

Shure Control
Primary and Secondary ports are configured are 2 separate networks 
to provide isolation between control signals and audio signals.

Setting the Dante Networking Mode
Select a Dante mode from the web application under Settings > IP Configuration to configure network signal routing on 
the Primary and Secondary ports. Set all receivers on the network to the same mode.

Note: Remove network connections from the receiver before changing the mode.

Network Connection and Configuration
Switched mode is typically used for single network installations of star or daisy-chained networks. Switched mode is recom-
mended for installations that don't require Dante audio.

Network characteristics:

Dante Audio and Shure Control are present on both the Primary and Secondary ports
The Dante IP address and the Shure Control IP address must be on the same subnet. The computer running Wireless 
Workbench must also be on this subnet.

Switch Recommendations for Dante Networking
In addition to the basic networking requirements, Dante audio networks should use a Gigabit network switch or router with the 
following features:

Gigabit ports
Quality of Service (QoS) with 4 queues
Diffserv (DSCP) QoS, with strict priority
Recommended: A managed switch to provide detailed information about the operation of each network link (port speed, 
error counters, bandwidth used)

QoS (Quality of Service) Settings
QoS settings assign priorities to specific data packets on the network, ensuring reliable audio delivery on larger networks with 
heavy traffic. This feature is available on most managed network switches. Although not required, assigning QoS settings is 
recommended.

Note: Coordinate changes with the network administrator to avoid disrupting service.
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To assign QoS values, open the switch interface and use the following table to assign Dante -associated queue values.

Assign the highest possible value (shown as 4 in this example) for time-critical PTP events
Use descending priority values for each remaining packet.

Dante QoS Priority Values

Priority Usage DSCP Label Hex Decimal Binary

High (4)
Time-critical PTP 
events

CS7 0x38 56 111000

Medium (3) Audio, PTP EF 0x2E 46 101110

Low (2) (reserved) CS1 0x08 8 001000

None (1) Other traffic BestEffort 0x00 0 000000

Note: Switch management may vary by manufacturer and switch type. Consult the manufacturer's product guide for specific configuration details.

For more information on Dante requirements and networking, visit www.audinate.com.

Networking Terminology
PTP (Precision Time Protocol): Used to synchronize clocks on the network
DSCP (Differentiated Services Code Point): Standardized identification method for data used in layer 3 QoS prioritization

Advanced Setup
More information on advanced networking is available at www.shure.com.

Device IP Configuration
This Shure device uses 2 IP addresses in Switched and Split modes: one for Shure control, and one for Dante audio and con-
trol. Redundant mode uses a third IP address as a Dante backup. For most installations, the Shure control and Dante audio IP 
addresses should be in the same subnet range.

Shure control
Carries data for Shure control software, firmware updates, and third-party control systems (such as AMX or Crestron)

Dante audio and control
Carries Dante digital audio and control data for Dante Controller
Requires a wired, gigabit Ethernet connection to operate

Note:Refer to our FAQ if you're using Shure profiles on NETGEAR M4250-series switches.

Ports, Protocols, and Firewall Rules
For information about IP ports and protocols or firewall rules, go to:

IP Ports and Protocols for Shure Devices
Firewall Rules for Shure Software Applications

Connecting to an External Control System
The MXW neXt system connects to an AMX or Crestron control system via the Ethernet. Use only one controller per system to 
avoid messaging conflicts.

For a comprehensive list of MXW neXt command strings, visit shure.com/en-US/docs/commandstrings/MXWneXt.

Connection: Ethernet (TCP/IP; MXW is the client)
Port: 2202

®

https://www.shure.com
https://service.shure.com/s/article/How-do-I-configure-a-NETGEAR-M4250-series-switch-to-use-Shure-profiles?language=en_US
https://www.shure.com/en-US/docs/systemrequirements/device-ports
https://www.shure.com/en-US/docs/systemrequirements/firewall-rules
https://www.shure.com/en-US/docs/commandstrings/MXWneXt
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Additional Resources
For additional Troubleshooting assistance or further information on complex installations, visit https://www.shure.com/support 
or contact your local Shure service center.

For digital audio networking help, advanced networking guidelines and Dante software troubleshooting, visit Audinate's website 
at www.audinate.com.

Using the 802.1X Security Protocol
MXW neXt supports the 802.1X security protocol. Once 802.1X is set up, its behavior varies depending on the device and the 
network mode. Learn to set up the 802.1X security protocol and select the right network mode for your setup in this section.

Set Up the 802.1X Protocol for a Device
Select Shure devices support the IEEE 802.1X port access protocol for network authentication.

Important: To use the 802.1X security protocol with Shure devices, set the network switch to multiple host authentication. You 
must also make accommodations to allow the audio NIC to connect to the network. The audio NIC doesn't support the 802.1X 
protocol.

To set up 802.1X, you will need:

Details about your authentication server's EAP method
Any required credentials or certificates for that method, for example:

MD5 and PWD
User ID and passphrase

TLS and PEAP
User ID and passphrase
Certificate (with certificate types) in the .PEM format

Any passwords to access the devices if they are password locked

Setting up 802.1X is a two-part process.

Step 1: Configure Settings on Test Network
Connect the device to a test network that does not have 802.1X enabled, and discover it using Designer.
Set a device password if desired.
Double-click the device and go to Settings > Network > 802.1X.
Choose your EAP method from the menu.
Enter any required credentials and load any necessary certificates.
Press Save to save the 802.1X settings to the device.
Enable 802.1X and select Reboot now.

Step 2: Connect to a Credentialed Network
Connect your device to the credentialed network.
Ensure that Designer is connected to the credentialed network.
Verify that the device appears in Designer. If it doesn't, reconnect to the test network and check all 802.1X settings for 
the selected EAP method.
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Choose a Network Mode for 802.1X
For devices with dual RJ45 ports, 8021.X behavior varies depending on the network mode. Use the information below to en-
sure your system configuration and device's network mode fit your security needs. MAC Authentication Bypass can be used 
alongside or instead of 802.1X, depending on the network mode on the device.

The APXD2, APXD4, and APXD8 have dual RJ45 ports and support three network modes: switched, split, and redundant. By 
default, the APX is set to switched, but split or redundant are recommended for 802.1X.

The NDX4, NDX4G, NDX8, and NDX8G have dual RJ45 ports and support only switched network mode.

802.1X in Switched Network Mode
Applies to: NDX4, NDX4G, NDX8, and NDX8G.

Applies to: APXD2, APX4, and APX8 when set to switched network mode.

When 802.1X is set up on a device in switched network mode, either the primary or the secondary port can be used for authen-
tication.

Important: When one port is used for authentication, connecting a device to the other port will grant that device access to the 
credentialed network without authenticating it. This access may not be desirable for your credentialed network. To prevent this, 
MAC Authentication Bypass (MAB) can be used in addition to 802.1X.

802.1X in Split Network Mode
Applies to: APXD2, APX4, and APX8 when set to split network mode.

When 802.1X is set up on a device in split network mode, the primary port is used for authentication. In this mode, the sec-
ondary port does not support 802.1X. If authentication to the credentialed network is required on the secondary port, use MAC 
Authentication Bypass (MAB) instead.

Important: When the primary port is used for authentication in split mode, connecting a device to the secondary port will not
grant that device access to the credentialed network.

Only control data is available on the credentialed network in split network mode. If you need audio on the credentialed network, 
use redundant network mode.

802.1X in Redundant Network Mode
Applies to: APXD2, APX4, and APX8 when set to redundant network mode.

When 802.1X is set up on a device in redundant network mode, the primary port is used for authentication. In this mode, the 
secondary port does not support 802.1X. If authentication to the credentialed network is required on the secondary port, use 
MAC Authentication Bypass (MAB) instead.

Important: When the primary port is used for authentication in redundant mode, connecting a device to the secondary port will 
not grant that device access to the credentialed network.

Both Dante audio and control are available on the credentialed network on the primary port in redundant network mode. Use 
redundant network node when both audio and control are needed.

Turn Off or Clear 802.1X Settings
You can turn off 802.1X settings temporarily, or clear them from the device. Open the device and go to Settings > Network
> 802.1X

Disable: Click the 802.1X switch to turn off 802.1X settings. Click the switch again to enable 802.1X.
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Clear: Click Clear 802.1X settings to remove 802.1X settings from the device.

Note: Resetting to factory default clears all 802.1X settings.

Change 802.1X Settings
You may need to change a device’s 802.1X settings if the enterprise’s 802.1X settings are changing. The best way to do this is 
to change the 802.1X settings on the devices, and then make changes to the authentication server.

To change device settings:

While still connected to the credentialed network, find the device in Designer and go to Settings > Network > 
802.1X.
Make changes and click Save.
Make any changes to the authentication server.
Reboot your devices. The devices should connect to the credentialed network with the updated 802.1X settings.

Troubleshooting 802.1X Setup Issues
If the device doesn’t appear in Designer on the credentialed network, there’s a problem with the device’s 802.1X settings. To 
troubleshoot, take the device off the credentialed network and connect it to the test network. You can make any necessary 
changes to the 802.1X settings, and then reconnect to the credentialed network.

If you attempt to enable 802.1X on a device, but the authentication fails, you will see this notification:

If this occurs, check with your system administrator.

MAC Authentication Bypass
MAC Authentication Bypass (MAB) is a network access control method used primarily in managed networks. MAB grants net-
work access to devices based on their MAC addresses when other authentication protocols, such as 802.1X, are not available 
or supported.

In switched mode, when the device has 802.1X enabled, both of the dual RJ45 ports provide access to the credentialed net-
work. If this is not desired, the network administrator must also use MAB to prevent unauthorized devices from accessing the 
credentialed network via the second port.

In the split and redundant network modes, the Dante interface on the secondary port does not support 802.1X. Therefore, if ac-
cess to the credentialed network is required on these ports, the network administrator must use MAB.

Updating MXW neXt Firmware
Firmware is embedded software in each component that controls functionality. Periodically, new versions of firmware are devel-
oped to incorporate additional features and enhancements. To take advantage of design improvements, new versions of the 
firmware can be uploaded and installed using the Shure Update Utility. Download the software from www.shure.com/suu.

Perform the following steps to update the firmware:

https://www.shure.com/suu
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CAUTION! Ensure the device has a stable network connection during the update. Do not turn off the device until the update is 
complete.

Connect the device and computer to the same network, set to the same subnet. (To update MXW neXt transmitters, 
place them in a docking station that is connected to the same network.)
Install and open the latest version of the Shure Update Utility.

Note: If you have previously installed the Shure Update Utility, launch the software and click Help > Check for Shure Update Utility updates
to ensure you have the latest version.

Click the Check For Updates... button to view new firmware versions available for download.
Select the desired firmware and press Download to download it to the Firmware Library.
From the Update Devices tab, select the new firmware and press Send Updates... to begin the firmware update, which 
overwrites the existing firmware on the device.

Firmware Versions and Compatibility
The firmware of all Shure devices has the form of MAJOR.MINOR.PATCH.BUILD (e.g., 1.2.14.0). To ensure interoperability, all 
rack and portable components from the same model family should be updated to the same MAJOR and MINOR firmware ver-
sion numbers (e.g., 1.2.x.x).

Resetting MXW neXt Hardware
To move a device to a different room or installation, or if a device isn't appearing on the network after trying troubleshooting 
methods, perform a network reset, or a full factory reset.

From the Control Software
Under the Settings > Reset tab:

Reboot Reboots the hardware.

Network Reset Clears all stored network data and sets the network mode to Switched.

Restore Factory Defaults

Resets the device to factory default settings, designed for automatic compatibility with other 
Shure networked devices.

CAUTION: A factory reset returns all audio settings to default and deletes all microphone 
links saved in the device.

Low Power Standby Mode 
(APXD2 only)

Enters low power standby mode. Short press the APXD2 hardware reset button to exit.

From the Hardware

Network Reset
Press and hold the recessed reset button for 5-8 seconds. LEDs will flash yellow to indicate 
the network settings have been reset, followed by the usual boot LED sequence.
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Restore Factory Defaults
Press and hold the recessed reset button for more than 8 seconds to reset the device to fac-
tory default settings. LEDs will flash green to indicate the device has been reset to factory 
settings, followed by the usual boot LED sequence.

Note: To factory reset MXW neXt microphones, factory reset the docking station they're docked in.

MXW neXt Model Variations and Accessories
MXW neXt Device Description Part Number

All-In-One Transceiver/
Docking Station/DSP

2-Channel Access Point Transceiver with 2 Charging Ports 
and Intellimix DSP

MXWAPXD2

Access Point Transcievers
4-Channel Access Point MXWAPX4

8-Channel Access Point MXWAPX8

Networked Docking Sta­
tions

4-Bay Docking Station (for Bodypack, Handheld, and 
Boundary Microphones)

MXWNDX4

8­Bay Networked Docking Station (for Bodypack, Hand­
held, and Boundary Microphones)

MXWNDX8

4-Bay Networked Docking Station (for Gooseneck and 
Boundary Microphones)

MXWNDX4G

8-Bay Networked Docking Station (for Gooseneck and 
Boundary Microphones)

MXWNDX8G

Transmitters

Bodypack w/o lavalier microphone MXW1X/O

Handheld

w/ SM58 cartridge MXW2X/SM58

w/ SM86 cartridge MXW2X/SM86

w/ Beta 58 cartridge MXW2X/BETA58

w/ VP68 cartridge MXW2X/VP68

Boundary
Omnidirectional microphone MXW6X/O

Cardioid microphone MXW6X/C

Gooseneck Black base MXW8X

Accessories

Rechargeable Li-Ion 
Battery

Compatible with MXW1X and 
MXW6X

SB906

Compatible with MXW2X and 
MXW8X

SB908

3.5mm-to-USB audio dongle AMXWX-USBC-3.5mm
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MXW neXt Device Description Part Number

Paintable cover for APX4/APX8 A-MXWAPX-CV

Lavalier Options

Microphone Description Part Number

Microflex  Omnidirectional Subminiature Earset, Black MX153B/O-TQG

Microflex Omnidirectional Subminiature Earset, Tan MX153T/O-TQG

Microflex Omnidirectional Subminiature Earset, Cocoa MX153C/O-TQG

Low-Profile Omnidirectional Lavalier, Black WL183mB/O-TQG

Low-Profile Omnidirectional Lavalier, White WL183mW/O-TQG

Low-Profile Supercardioid Lavalier, Black WL184mB/O-TQG

Low-Profile Supercardioid Lavalier, White WL184mW/O-TQG

Low-Profile Cardioid Lavalier, Black WL185mB/O-TQG

Low-Profile Cardioid Lavalier, White WL185mW/O-TQG

Omnidirectional Condenser Miniature Lavalier, Black WL93

Gooseneck Options

Microphone Description Polar Pattern Length Part Number

Bi­color LED status indica­
tor

Cardioid 5" (12.7 cm) MX405LP/C

Supercardioid 5" (12.7 cm) MX405LP/S

Mini-shotgun 5" (12.7 cm) MX405LP/MS

Cardioid 10" (25.4 cm) MX410LP/C

Supercardioid 10" (25.4 cm) MX410LP/S

Cardioid 15" (38.1 cm) MX415LP/C

Supercardioid 15" (38.1 cm) MX415LP/S

Light ring indicator No cartridge included

5" (12.7 cm) MX405RLP/N

10" (25.4 cm) MX410RLP/N

15" (38.1 cm) MX415RLP/N

Capsule only

Cardioid for any length R185B

Supercardioid for any length R184B

Mini-shotgun 5" (12.7 cm) R189B

®
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AC Adapter (45W, USB-C, 2m cable)

USB Power Supply by Region Part Number

USA, Japan, and Taiwan SBC10-USB45WPD-UTJ

UK SBC10-USB45WPD-UK

Europe SBC10-USB45WPD-E

Argentina SBC10-USB45WPD-AR

Australia SBC10-USB45WPD-AZ

Brazil SBC10-USB45WPD-BR

India SBC10-USB45WPD-IN

South Korea SBC10-USB45WPD-K

MXW neXt Specifications
MXW neXt System Specifications

RF Carrier Frequency Range

Band Frequency Range Region(s)
Unit Density**

Standard (SD) High (HD)

Z10 1920 MHz ‒ 1930 MHz USA, Canada, Mexico

APX4/8: 40 APX4/8: 80

APXD2: 30 APXD2: 60

Z11* 1880 MHz ‒ 1900 MHz
Europe, South Africa, Asia, 
Australia, Middle East

APX4/8: 80 APX4/8: 160

APXD2: 60 APXD2: 120

Z12 1884 MHz ‒ 1906 MHz Japan
APX4/8: 64 + 16 APX4/8: 128 + 32

APXD2: 48 + 12 APXD2: 96 + 24

Z14 1910 MHz ‒ 1920 MHz
Brazil, Latin America, South 
America

APX4/8: 40 APX4/8: 80

APXD2: 30 APXD2: 60

Z15 1880 MHz ‒ 1895 MHz Taiwan
APX4/8: 64 APX4/8: 128

APXD2: 48 APXD2: 96

Z16 1880 MHz ‒ 1890 MHz Phillippines APX4/8: 40 APX4/8: 80

✝ ✝

✝ ✝
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Band Frequency Range Region(s)
Unit Density**

Standard (SD) High (HD)

APXD2: 30 APXD2: 60

* Maximum RF power for Egypt SKUs is less than 50 mW EIRP

** MXWAPXD2 transmits additional system information over the available spectrum, leaving fewer slots for microphone chan-
nels

 Additional channels available if no other PHS systems are detected

Working Range
45 m (150 ft)

Outdoor and line-of-sight between user and MXWAPX. Actual range depends on RF power setting, signal 
absorption, reflections, and interference.

Audio Frequency Response
30 Hz ‒ 19 kHz (+0.5dB/3dB)

Dependent on microphone type and audio output. Microphone transducers not included in measurement. 
MXWAPX set to Direct Mode.

Digital Audio Processing
24 bit / 48 kHz

Digital Audio Networking
Dante, AES67

Security
AES-256 Encryption

Dante and DECT over-the-air

Latency
18 ms (nominal)

MXW1/2/6/8X microphone input to MXWAPX output. MXWAPX set to SD RF density mode. Latency de-
pends on output port and RF density mode.

System Audio Polarity
Positive pressure on MXW1X/2X/6X/8X microphone diaphragm produces positive voltage on + pin (with re-
spect to - pin) of MXWAPX analog output and a positive digital signal on the MXWAPX USB and Dante out-
puts.

Radio Transmission
Time Division Multiple Access (TDMA), Gaussian Frequency Shift Keying (GFSK), 365 kHz max. deviation

✝
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DECT RF Sensitivity
< -90 dBm

DECT RF Transmission Power
RF Power: Low 2 dBm; 2 mW

RF Power: Medium 9 dBm; 8 mW

RF Power: High 16 dBm (Egypt: 12 dBm); 40 mW (Egypt: 16 dBm)

RF Power: Maximum 21 dBm (Egypt: 15 dBm); 125 mW (Egypt: 32 mW)

Cable Requirements
Cat 5e or higher, shielded, 100 m maximum between network devices

Network Addressing Capability
DHCP, link-local, static

Operating Temperature Range
5℃ (41℉) - 40℃ (104℉)

Operating Humidity
RH < 95%

Storage Temperature Range
-20℃ (-4℉) to 60℃ (140℉)

MXWAPXD2 2-Channel Access Point Dock Specifications

Analog Input
Maximum Input Level

Line Level Input +28 dBV

Aux Level Input +15 dBV

Frequency Response
20 Hz ‒ 26 kHz (+0.5 dB / -3 dB)

Total Harmonic Distortion + Noise
Line Level Input 0.03% (typical)

Aux Level Input 0.02% (typical)

Dynamic Range
115 dB (A-weighted), 113 dB (unweighted), typical

Line and Aux level input setting. Measured at Dante output. MXWAPXD2 set to Direct Mode.
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Preamplifier Equivalent Input Noise
Line Level Input -87 dBV (A-weighted), typical, 22 Hz ‒ 22 kHz BW

Aux Level Input -99 dBV (A-weighted), typical, 22 Hz ‒ 22 kHz BW

Input Impedance
Line Level Input ~2.9 kΩ @ 1 kHz

Aux Level Input ~3.1 kΩ @ 1 kHz

Configuration
Balanced

Type
3-pin Phoenix: Pin 1 = Ground, Pin 2 = Audio +, Pin 3 = Audio -

Analog Outputs
Maximum Output Level

Line Level Output +17 dBV

Aux Level Output +6 dBV

Mic Level Output -13 dBV

Frequency Response
20 Hz ‒ 22 kHz (+0.5 dB / -3 dB)

Total Harmonic Distortion + Noise
0.02%, typical

Line, Aux, Mic output level settings

Dynamic Range
118 dB (A-weighted), 115 dB (unweighted), typical

Audio injected at Dante input. MXWAPXD2 set to Direct Mode.

Load Impedance
>600 Ω, typical

Type
3-pin Phoenix: Pin 1 = Ground, Pin 2 = Audio +, Pin 3 = Audio -

Power
Power Requirement

4.5V ‒ 5.5V, 2500 mA (via USB-C)
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Power Consumption
12.5 W (typical)

Network Interface
Dual ‒ RJ45: Gigabit Ethernet, Dante digital audio

Docking Interface
5 V / 0.5 A

SBC10-USB45WPD-* Power Supply
Input (100-240 V AC) 50-60 Hz, 1.2 A

Output (5.0 V / 9.0 V / 12.0 V / 15.0 V DC) 3.0 A, 45.0 W (max)

Output (20.0 V DC) 2.25 A, 45.0 W (max)

* Varies by region: UTJ, UK, E, AR, AZ, BR, IN, K

Housing
Antenna Type

Internal Shure Custom PIFA

Housing
Molded Plastic Cover with Cast Zinc Metal Base

Dimensions
252.7mm × 202.7mm × 48.8mm (9.95" × 7.98" × 1.92")

Weight
1111g

MXWAPX4, MXWAPX8 Access Point Specifications

Analog Outputs
Maximum Output Level

Line Level Output +17 dBV

Aux Level Output +6 dBV

Mic Level Output -13 dBV

Frequency Response
20 Hz ‒ 22 kHz (+0.5 dB / -3 dB)

Total Harmonic Distortion + Noise
0.02%, typical

Line, Aux, Mic output level settings
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Dynamic Range
118 dB (A-weighted), 115 dB (unweighted), typical

Audio injected at Dante input. MXWAPX set to Direct Mode.

Load Impedance
>600 Ω, typical

Type
3-pin Phoenix: Pin 1 = Ground, Pin 2 = Audio +, Pin 3 = Audio -

Power
Power Requirement

37V ‒ 57V, 12.95 W PoE Class 3

Network Interface
Dual ‒ RJ45: Gigabit Ethernet, Dante digital audio

Housing
Antenna Type

Internal Shure Custom PIFA

Housing
Molded Plastic Cover with Cast Zinc Metal Base

Dimensions
252.7mm × 202.7mm × 48.8mm (9.95" × 7.98" × 1.92")

Weight
1111g

MXWNDX4, MXWNDX4G, MXWNDX8, MXWNDX8G Networked Docking Station 
Specifications
Operating Temperature Range

5℃ (41℉) - 40℃ (104℉)

Storage Temperature Range
-20℃ (-4℉) to 60℃ (140℉)

Power Supply
USB 15 V / 3 A power supply (SBC10-USB45WPD-*)

* Varies by region: UTJ, UK, E, AR, AZ, BR, IN, K
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Bluetooth Frequency Range
2402 MHz - 2480 MHz

Bluetooth Output Power
10 dBm EIRP

Antenna Type
Internal

Specifications for MXW neXt Transmitters
SBC10-USB15WSUSTWJ Power Supply (USA, Canada, Taiwan, Japan)

Input 100-240 V AC, 50-60 Hz, 0.6 A

Output 5 V DC, 3.0 A, 15.0 W (max)

SBC10-USB Power Supply (all other countries)
Input 100-240 V AC, 50-60 Hz, 0.2 A

Output 5 V DC, 1.0 A, 5.0 W (max)

Microphone Transmitter Output Power
Low -2 dBm

Medium 5 dBm

Medium High 12 dBm

High 17 dBm

Headphone Output Configuration
Dual mono

Will drive stereo and mono headphones

Headphone Output Connector Type
USB-C Audio Adapter Accessory Mode, via USB-C to TRS Adapter

Headphone Output Connector Pinout
USB Dn = Tip Left audio output

USB Dp = Ring Right audio output

USB SBU1/2 = Sleeve Ground

Charge Connector
USB 2.0 Type C

Antenna Type
Internal chip antenna
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Housing
Molded plastic

MXW1X Hybrid Bodypack Specifications

External Microphone Input
Maximum Input Level

-1 dBV

Frequency Response
27 Hz ‒ 19 kHz (+0.5 dB / -3 dB)

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Dynamic Range
112 dB (A-weighted), 111 dB (unweighted), typical

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Preamplifier Equivalent Input Noise
-116 dBV (A-weighted), typical

22 Hz ‒ 22 kHz BW

Input Impedance
~30 kΩ @ 1 kHz

Configuration
Unbalanced

Connector Type
4-Pin male mini connector (TA4M)

Pinout
1 = Ground, 2 = 5V DC, 3 = Audio Input, 4 = Active Load

Internal Microphone Input
Frequency Response

27 Hz ‒ 20 kHz (+5 dB / -3 dB)

Dynamic Range
112 dB (A-weighted), 111 dB (unweighted), typical

Measured at MXWAPX Dante output. MXWAPX set to Direct Mode.
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Type
Omnidirectional Digital MEMS microphone

Headphone Output
Maximum Output Level

-1 dBV

Volume = 100%

Frequency Response
19 Hz ‒ 19 kHz (+0.5 dB / -3 dB)

Dynamic Range
100 dB (A-weighted), 98 dB (unweighted), typical

Audio injected at MXWAPX Dante input. Headphone transducer not included in measurement. Volume = 
100%.

Load Impedance
>8 kΩ, typical

Headphone outputs are protected against short circuits.

Max Headphone Output Power
1.5 mW

8Ω load, 1 kHz sine wave

Power
Battery Type

Shure SB906 Rechargeable Li-Ion

Battery Life
Up to 17 hours

Measured with a new battery. Runtimes vary depending on conditions like headphone level, battery health 
and RF density mode.

Battery Charge Time From Empty
Docked in APXD2 3 hours

Docked in NDX4/8 3 hours

Housing
Dimensions

101.5 mm × 47.0 mm × 23.5 mm (3.99" × 1.85" × 0.93")
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Weight
With Battery 0.095 kg

Without Battery 0.075 kg

MXW2X Handheld Microphone Specifications

External Microphone Head Input
Maximum Input Level

-9 dBV

Frequency Response
40 Hz ‒ 14 kHz (+0.5 dB / -3 dB)

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Dynamic Range
111 dB (A-weighted), 108 dB (unweighted), typical

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Preamplifier Equivalent Input Noise
-116 dBV (A-weighted), typical

22 Hz ‒ 22 kHz BW

Input Impedance
2 kΩ @ 1 kHz

Configuration
Unbalanced

Microphone Capsule
SM58, SM86, Beta 58, VP68

Headphone Output
Maximum Output Level

-1 dBV

Volume = 100%

Frequency Response
27 Hz ‒ 19 kHz (+0.5 dB / -3 dB)
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Dynamic Range
100 dB (A-weighted), 98 dB (unweighted), typical

Audio injected at MXWAPX Dante input. Headphone transducer not included in measurement. Volume = 
100%.

Load Impedance
>8 kΩ, typical

Headphone outputs are protected against short circuits.

Max Headphone Output Power
1.5 mW

8Ω load, 1 kHz sine wave

Power
Battery Type

Shure SB908 Rechargeable Li-Ion

Battery Life
Up to 39 hours

Measured with a new battery. Runtimes vary depending on conditions like headphone level, battery health 
and RF density mode.

Battery Charge Time From Empty
Docked in APXD2 7 hours

Docked in NDX4/8 4 hours

Housing
Dimensions

228.5 mm × 51.0 mm × 51.0 mm (8.99" × 2.01" × 2.01")

Weight
With Battery 0.380 kg

Without Battery 0.330 kg

MXW6X Boundary Microphone Specifications

Internal Microphone Input
Frequency Response

27 Hz ‒ 19 kHz (+3 dB / -3 dB)

Measured at MXWAPX Dante output. MXWAPX set to Direct Mode.
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Dynamic Range
112 dB (A-weighted), 110 dB (unweighted), typical

Measured at MXWAPX Dante output. MXWAPX set to Direct Mode.

Type
Cardioid or Omnidirectional Condensor Capsule

Headphone Output
Maximum Output Level

-1 dBV

Volume = 100%

Frequency Response
27 Hz ‒ 19 kHz (+0.5 dB / -3 dB)

Dynamic Range
100 dB (A-weighted), 98 dB (unweighted), typical

Audio injected at MXWAPXD2 Dante input. Headphone transducer not included in measurement. Volume = 
100%.

Load Impedance
>8 kΩ, typical

Headphone outputs are protected against short circuits.

Max Headphone Output Power
1.5 mW

8Ω load, 1 kHz sine wave

Power
Battery Type

Shure SB906 Rechargeable Li-Ion

Battery Life
Up to 17 hours

Measured with a new battery. Runtimes vary depending on conditions like headphone level, battery health 
and RF density mode.

Battery Charge Time From Empty
Docked in APXD2 3 hours

Docked in NDX4/8/4G/8G 3 hours
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Docked in an APXD2

Housing
Dimensions

118.43 mm × 46.99 mm × 26.10 mm (4.66" × 1.85" × 1.03")

Weight
With Battery 0.115 kg

Without Battery 0.090 kg

MXW8X Gooseneck Base Specifications

External Microphone Input
Maximum Input Level

-1 dBV

Frequency Response
26Hz - 20kHz (+3dB/-3dB)

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Dynamic Range
113 dB (A-weighted), 111 dB (unweighted), typical

Measured at MXWAPX Dante output. Microphone transducer not included in measurement. MXWAPX set 
to Direct Mode.

Preamplifier Equivalent Input Noise
-117 dBV (A-weighted), typical

22 Hz ‒ 22 kHz BW

Input Impedance
42 kΩ @ 1 kHz

Configuration
Unbalanced

Connector Type
6-pin connector for Shure MX405/410/415

Headphone Output
Maximum Output Level

-1 dBV
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Volume = 100%

Frequency Response
27 Hz ‒ 19 kHz (+0.5 dB / -3 dB)

Dynamic Range
100 dB (A-weighted), 98 dB (unweighted), typical

Audio injected at MXWAPX Dante input. Headphone transducer not included in measurement. Volume = 
100%.

Load Impedance
>8 kΩ, typical

Headphone outputs are protected against short circuits.

Max Headphone Output Power
1.5 mW

8Ω load, 1 kHz sine wave

Power
Battery Type

Shure SB908 Rechargeable Li-Ion

Battery Life
Up to 30 hours

Measured with a new battery. Runtimes vary depending on conditions like headphone level, battery health 
and RF density mode.

Battery Charge Time From Empty
Docked in NDX4G/8G 4 hours

Housing
Dimensions

133.32mm × 78.20mm × 34.08mm (5.249" × 3.079" × 1.342")

Weight
With Battery 0.245 kg

Without Battery 0.195 kg

No microphone attached
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Regulatory Information for Wireless Products Utilizing TV 
and DECT Frequency Bands
CE Notice
Hereby, Shure Incorporated declares that this product with CE Marking has been determined to be in compliance with Euro-
pean Union requirements.

The full text of the EU declaration of conformity is available at the following site: https://www.shure.com/en-EU/support/declara-
tions-of-conformity.

UKCA Notice
Hereby, Shure Incorporated declares that this product with UKCA Marking has been determined to be in compliance with UK-
CA requirements.

The full text of the UK declaration of conformity is available at the following site: https://www.shure.com/en-GB/support/declara-
tions-of-conformity.

Cybersecurity STATEMENT OF COMPLIANCE
Product Type: Relevant connectable products defined as internet-connectable products or network-connectable products, in 
line with inter alia Product Security and Telecommunications Infrastructure Act 2022.

Manufacturer Statement: We, Shure Incorporated, certify and declare as manufacturer under our sole responsibility, that the 
above-mentioned product(s) conform(s) to the legislation as mentioned under Attachment 1 – to Cybersecurity Statement of 
Compliance listed here: https://www.shure.com/en-GB/about-us/security.

Information on how to report security issues: The latest version of Shure's Disclosure policy can be found at the following 
link: https://www.shure.com/en-GB/about-us/security

Security update periods: Shure provides support regarding hardware and software updates that continue the integral cyber 
security safety of Shure products up to 24 months after end of life (AEOL). For the full statement regarding Shure's product 
support policy, and information regarding products end of life status information can be found at the following link: https://
www.shure.com/en-GB/about-us/security

Manufacturer: 
Shure Incorporated 5800 Touhy Avenue 
Niles, Illinois, 60714-4608 U.S.A. Website: www.Shure.com. 

Technical documentation is kept at: 
Shure Incorporated, Corporate Global Compliance Engineering Division

UK Importer/Representative:
Shure UK Limited
Unit 2, The IO Centre, Lea Road, Waltham Abbey, Essex, EN9 1AS, U.K. 
Phone: +44 (0)1992 - 703058
Email: EMEAsupport@shure.de

On behalf of Manufacturer:

https://www.shure.com/en-EU/support/declarations-of-conformity
https://www.shure.com/en-EU/support/declarations-of-conformity
https://www.shure.com/en-GB/support/declarations-of-conformity
https://www.shure.com/en-GB/support/declarations-of-conformity
https://www.shure.com/en-GB/about-us/security
http://www.shure.com/en-GB/about-us/security
https://www.shure.com/en-GB/about-us/security
https://www.shure.com/en-GB/about-us/security
http://www.Shure.com/
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Chad Ayers
08 May 2025 Niles, Illinois
Senior Director, Global Compliance

FCC Notice
This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operat-
ed in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference with radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference with ra-
dio or television reception, which can be determined by turning the equipment off and on, you are encouraged to try to correct 
the interference by one or more of the following measures:

Reorient or relocate the antenna of the radio/television receiver.
Increase the separation between this equipment and the radio/television receiver.
Plug the equipment into a different outlet so that the equipment and the radio/television receiver are on different power 
mains branch circuits.
Consult a representative of Shure or an experienced radio/television technician for additional suggestions.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

This device may not cause harmful interference.
This device must accept any interference received, including interference that may cause undesired operation.

Notice: The FCC regulations provide that changes or modifications not expressly approved by Shure Incorporated could void your authority to operate this 
equipment.

For information regarding responsible party and other matters relating to FCC compliance, please contact Shure Incorporated, 
5800 W. Touhy Avenue, Niles, Illinois 60714-4608 U.S.A. shure.com/contact

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. End user must follow 
the specific operating instructions for satisfying RF exposure compliance. This transmitter must not be co-located or operating 
in conjunction with any other antenna or transmitter.

Industry Canada (IC) Notices
This device contains licence-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and Economic Develop-
ment Canada’s licence-exempt RSS(s). Operation is subject to the following two conditions:

This device may not cause interference.
This device must accept any interference, including interference that may cause undesired operation of the device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation, Sciences et 
Développement économique Canada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux 
conditions suivantes :

L’appareil ne doit pas produire de brouillage;
L’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le 
fonctionnement.

This Class B digital apparatus complies with Canadian ICES-003. Cet appareil numérique de la classe B est conforme à la 
norme NMB-003 du Canada.

https://www.shure.com/en-US/about-us/contact-us
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Canada Warning for Wireless
This device operates on a no-protection, no-interference basis. Should the user seek to obtain protection from other radio ser-
vices operating in the same TV bands, a radio licence is required. For further details, consult Innovation, Science and Econom-
ic Development Canada’s document Client Procedures Circular CPC-2-1-28, Voluntary Licensing of Licence-Exempt Low-Pow-
er Radio Apparatus in the TV Bands.

Ce dispositif fonctionne selon un régime de non‑brouillage et de non‑protection. Si l’utilisateur devait chercher à obtenir une 
certaine protection contre d’autres services radio fonctionnant dans les mêmes bandes de télévision, une licence radio serait 
requise. Pour en savoir plus, veuillez consulter la Circulaire des procédures concernant les clients CPC‑2‑1‑28, Délivrance de 
licences sur une base volontaire pour les appareils radio de faible puissance exempts de licence et exploités dans les bandes 
de télévision d’Innovation, Sciences et Développement économique Canada.

This equipment complies with ISED radiation exposure limits set forth for an uncontrolled environment. End user must follow 
the specific operating instructions for satisfying RF exposure compliance. This transmitter must not be co-located or operating 
in conjunction with any other antenna or transmitter.

Cet équipement est conforme aux limites d’exposition aux rayonnements ISED établies pour un environnement non contrôlé. 
L’utilisateur final doit suivre les instructions spécifiques pour satisfaire les normes. Cet émetteur ne doit pas être co-implanté ou 
fonctionner en conjonction avec toute autre antenne ou transmetteur.

Additional Canadian information on RF exposure also can be found at the following Web address: http://www.ic.gc.ca/eic/site/
smt-gst.nsf/eng/sf08792.html

ANATEL Notice
Este equipamento não tem direito à proteção contra interferência prejudicial e não pode causar interferência em sistemas dev-
idamente autorizados. Para maiores informações, consulte o site da ANATEL – http://www.anatel.gov.br.

IFETEL Notice
La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo o dispositivo no 
cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda 
causar su operación no deseada.

K-DECT Warning Statement
이 장치는 보안성이 없으며 운용 중 혼신 가능성이 있음

MIC Notice
運用に際しての注意

この機器の使用周波数帯では、電子レンジ等の産業・科学・医療用機器のほか工場の製造ライン等で使用されている移動体識別用の

構内無線局（免許を要する無線局）及び特定小電力無線局（免許を要しない無線局）並びにアマチュア無線局（免許を要する無

線局）が運用されています。

この機器を使用する前に、近くで移動体識別用の構内無線局及び特定小電力無線局並びにアマ 　 チュア無線局が運用さ

れていないことを確認して下さい。

万一、この機器から移動体識別用の構内無線局に対して有害な電波干渉の事例が発生した場合には、 速やかに使用周波

数を変更するか又は電波の発射を停止した上、下記連絡先にご連絡頂き、混　 信回避のための処置等（例えば、パーティ

ションの設置など）についてご相談して下さい。

その他、この機器から移動体識別用の特定小電力無線局あるいはアマチュア無線局に対して有害な電波干渉の事例が発生

した場合など何かお困りのことが起きたときは、保証書に記載の販売代　 理店または購入店へお問い合わせください。代

理店および販売店情報は Shure 日本語ウェブサイト　 http://www.shure.co.jp でもご覧いただけます。

現品表示記号について

http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html
http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html
http://www.anatel.gov.br
http://www.shure.co.jp
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現品表示記号は、以下のことを表しています。 この無線機器は 2.4GHz 帯の電波を使用し、変調方式は「FH-SS」方式、想定与干

渉距離は 10m です。 2,400MHz～2,483.5MHz の全帯域を使用し、移動体識別装置の帯域を回避することはできません。

NCC Notice
低功率射頻器材技術規範

取得審驗證明之低功率射頻器材，非經核准，公司、商號或使用者均不得擅自變更頻率、加大功率或變更原設計之特性及功能。

低功率射頻器材之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方得繼續使

用。前述合法通信，指依電信管理法規定作業之無線電通信。低功率射頻器材須忍受合法通信或工業、科學及醫療用電波輻射性

電機設備之干擾。

614MHz-703MHz: 使用頻段供其他通訊業務使用時，器材應即停止使用

減少電磁波影響，請妥適使用。

NBTC Notice
เครื่องโทรคมนาคมและอุปกรณ์นี้มีความสอดคล้องตามมาตรฐานหรือข้อกำหนดทางเทคนิคของ กสทช.

Environmental Regulatory Information

Waste Electrical and Electronic Equipment (WEEE) Directive

In the European Union and the United Kingdom, this label indicates that this product should not be disposed of with household 
waste. It should be deposited at an appropriate facility to enable recovery and recycling.

Registration, Evaluation, Authorization of Chemicals (REACH) Directive
REACH (Registration, Evaluation, Authorization of Chemicals) is the European Union (EU) and the United Kingdom (UK) 
chemical substances regulatory framework. Information on substances of very high concern contained in Shure products in a 
concentration above 0.1% weight over weight (w/w) is available upon request.

Recycling Information
Please consider the environment, electric products and packaging are part of regional recycling schemes and do not belong to 
regular household waste.

Certifications
Regulatory Model Number (RMN)
For regulatory identification purposes your product has been assigned a regulatory model number (RMN). This regulatory mod-
el number should not be confused with product number.
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RMN: MXW1X
Product Numbers: MXW1X/O Z10, MXW1X/O Z11, MXW1X/O Z12, MXW1X/O Z14, 
MXW1X/O Z15

RMN: MXW2X Product Numbers: MXW2X Z10, MXW2X Z11, MXW2X Z12, MXW2X Z14, MXW2X Z15

RMN: MXW6X

Product Numbers: MXW6X/C Z10, MXW6X/C Z11, MXW6X/C Z12, MXW6X/C Z14, 
MXW6X/C Z15, MXW6X/O Z10, MXW6X/O Z11, MXW6X/O Z12, MXW6X/O Z14, MXW6X/O 
Z15, MXW6XW/C Z10, MXW6XW/C Z11, MXW6XW/C Z12, MXW6XW/C Z14, MXW6XW/C 
Z15, MXW6XW/O Z10, MXW6XW/O Z11, MXW6XW/O Z12, MXW6XW/O Z14, MXW6XW/O 
Z15

RMN: MXW8X
Product Numbers: MXW8X Z10, MXW8X Z11, MXW8X Z12, MXW8X Z14, MXW8X Z15, 
MXW8XW Z10, MXW8XW Z11, MXW8XW Z12, MXW8XW Z14, MXW8XW Z15

RMN: MXWAPXD2
Product Numbers: MXWAPXD2 Z10, MXWAPXD2 Z11, MXWAPXD2 Z12, MXWAPXD2 
Z14, MXWAPXD2 Z15

RMN: MXWAPX
Product Numbers: MXWAPX4 Z10, MXWAPX4 Z11, MXWAPX4 Z12, MXWAPX4 Z14, 
MXWAPX4 Z15, MXWAPX8 Z10, MXWAPX8 Z11, MXWAPX8 Z12, MXWAPX8 Z14, 
MXWAPX8 Z15

FCC / IC ID
FCC ID: DD4MXW1X, DD4MXW2X, DD4MXW6X, DD4MXW8X, DD4MXWAPXD2, DD4MXWNDX4, DD4MXWNDX4G, 
DD4MXWNDX8, DD4MXWNDX8G, DD4MXWAPX

IC: 616A-MXW1X, 616A-MXW2X, 616A-MXW6X, 616A-MXW8X, 616A-MXWAPXD2, 616A-MXWNDX4, 616A-MXWNDX4G, 
616A-MXWNDX8, 616A-MXWNDX8G, 616A-MXWAPX

Energy Efficiency
External Power Supply meets:

1. The U.S. Energy Conservation Standards specified in the Code of Federal Regulations at 10 CFR 430 32(w).

2. EU COMMISSION REGULATION (EU) 2019/1782 of 1 October 2019: Ecodesign requirements for External Power Supply.

3. Australian Standard requirements of AS/NZS 4665.1:2005 and AS/NZS 4665.2:2005.

Battery Charger System meets:

1. The U.S. Energy Conservation Standards specified in the Code of Federal Regulations at 10 CFR 430 32(z)

2. Canada NRCan standard: CAN/CSA-C381.2

Certification and Compliance Markings

Trademarks
Audinate , the Audinate logo and Dante  are trademarks of Audinate Pty Ltd.® ®
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